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CHAPTER

ONE

INTRODUCTION

Welcome to the Mahara User Guide. This user guide is designed to provide documentation for people who will
use Mahara on a day-to-day basis. This document is designed to be read by any user of Mahara, as most users
will have access to the features documented here. Site and Institution Administrator functionalities are covered in
a separate section of this guide.

Without any further ado, let’s begin!

1.1 What is Mahara?

If you’re wondering what Mahara or an ePortfolio is, why you might want one and what it can do for you, then
read on – you’re about to find out.

At the simplest level, Mahara is two things: an ePortfolio and a social networking system combined. An ePortfolio
is a system in which students can record “evidence of lifelong learning” – such as essays, artwork or other such
things they produce that can be stored digitally. Such things are known as artefacts in Mahara. Social networking
systems need little introduction – think Bebo, Facebook or MySpace. Basically, they give a way for people to
interact with their friends and create their own online communities.

But Mahara is much more than just a place to store files. Mahara also includes blogging, a resumé builder, and
Moodle integration.

1.2 The Mahara framework

With Mahara, you control which items and what information within your portfolio other users see. Such items
and information are termed artefacts. To facilitate this access control, all artefacts you wish to show to other users
need to be arranged into one area. In Mahara this compilation of selected artefacts is called a ‘page’. You can
have as many pages as you like, each with a different number of artefacts, intended purpose and audience. Your
audience, or the people you wish to give access to your page, can be added as individuals or as a member of a
group. It can even be made publicly available.

For example you could create:

• a page for your friends and family that includes holiday photos and a personal journal

• a page for your tutor, which includes assessments and your reflective learning journal

• a page to showcase your best pieces of work and your resumé for potential employers

• ...

A single page or a collection of pages can make up your portfolio. Unless artefacts are placed in a page, they are
not visible to anybody but you. You can use files that you uploaded or journal entries you wrote in as many pages
as you wish. You only need one copy of your artefact.

Imagine you collected all your artefacts in a shoe box. Whenever you have a new artefact, you add it to the shoe
box. When you are ready to create your portfolio, you take a look at the artefacts in your shoe box and choose

3
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those that you want ot make available on a portfolio page. You can arrange the artefacts on that page to your
liking.

Figure 1.1: Portfolio work with Mahara

The diagram below of example artefacts, pages and groups illustrates how content in Mahara can be shared and
reused in different contexts and for different audiences.

1.3 How does Mahara fit in to the e-learning landscape?

If you think of LMSs such as Moodle, Sakai and Blackboard as the formal, structured side of e-learning, then
Mahara is the social, reflective side. An LMS and an ePortfolio complement one another in an online learning
environment.

In particular, while Mahara’s APIs are open to all, Mahara can integrate with Moodle natively to provide a stream-
lined user experience. Since Moodle 2.0 this is not only limited to SSO via MNet, but students are able to export
assignments, blogs and much more straight into Mahara to use as artefacts – which can then, of course, be placed
into pages.

1.4 What if Mahara does not support a feature I want?

Mahara has been designed from the ground up to be an open, pluggable system. Creating new artefacts, authen-
ticating against a custom system and much more can be implemented simply through writing a plugin that uses
the appropriate core API. What this means is that it is free and easy for you to customise almost anything about
Mahara to suit your needs – and paid support is available through a network of Mahara Partners should you require
it.

1.5 Other things to do

Now you have a basic idea of what Mahara is, you could:

• Read the list of features that Mahara comes with.

• Explore the demo or download mahara for yourself to play with.

• Sign up to the mahara.org community and begin asking questions and contributing in the forums.

• Continue reading this user guide!

4 Chapter 1. Introduction
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1.6 Where can I get ideas of how to use Mahara?

The Mahara 1.4 Cookbook by Ellen Marie Murphy was published in September 2011. It has over 50 ideas of how
to use Mahara in different settings. The book can be purchased in PDF and paper formats.

1.7 Getting help

• Contextual help in available throughout Mahara. Watch out for the Help icon . Click on it to find out
more about the action you are about to perform.

• You can also ask questions in the forums.

6 Chapter 1. Introduction
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CHAPTER

TWO

DASHBOARD

After you successfully logged in to Mahara, you see your dashboard. This is your homepage where you can see
the latest activity of you and other users on Mahara. You can customise the dashboard so that you always see the
items that are most important to you.

Only you can see your dashboard. Nobody else has access to it.

2.1 Overview

You can change certain aspects of your dashboard, namely the user-specific information, but a lot of what you see
is static to allow you to quickly access other parts of Mahara.

Figure 2.1: Your homepage is your dashbaord from which you can access a number of areas in Mahara conve-
niently.

1. General navigation bar: Move from one area of Mahara to the next.

2. Settings: This link gives you access to your account settings and notifications.

3. Inbox: Go to your Mahara inbox to check for new messages. When you have unread messages, the counter
displays the number of unread messages.

7
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4. Logout: Link to log out of your current session.

5. User search: Search for users who have an account to view their portfolio pages / collections.

6. Personal information: In this box a number of constant and dynamic information is displayed:

• Your name is linked to your profile page.

• Your profile picture is linked to your profile page.

• If you are a member of any groups, they are displayed here.

• Pending friend requests are displayed.

• If you tagged artefacts or pages with the tag “portfolio”, a link to them is placed here.

7. Online users: If this sidebar block is enabled, you see all users who have been logged in during the last 10
minutes.

8. Quick links: These quick links take you to certain areas of Mahara fast.

9. User-specific information: You can customise this area on your dashboard to put blocks there that you
want to see every time you log in.

2.2 Quick links

When you log in to Mahara for the first time, you see three boxes with quick links:

• Create and Collect: Develop your portfolio

• Organise: Showcase your portfolio

• Share and Network: Connect with friends and collaborate in groups

Figure 2.2: Mahara information

With the help of these quick links you can reach the different parts of your portfolio directly from your dashboard.

Note: If you removed these boxes from your dashbaord but want to get them back at a later point, you can
re-active them under Settings -> Show information about Mahara on the home page.

2.3 User-specific information

The default dashboard includes the following blocks:

• Latest Pages

8 Chapter 2. Dashboard
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• My Pages

• Recent Activity

• Topics I’m Following

These areas are filled with content once you start using Mahara and create pages, receive messages from other
users, have access to others’ portfolio pages and use the forums for discussions. You can customize this area to

your liking by editing your dashboard in Portfolio -> click the Edit button next to the dashboard page ->
change the blocks like you would change them on any page in Mahara.

See Also:

Refer to the page editor for more information on adding and removing blocks from a page.

2.3. User-specific information 9
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CHAPTER

THREE

CONTENT

3.1 Profile

Your profile page is visible to other users on Mahara by default. If the site administrator allowed it, you can also
make it visible to anybody on the Internet.

Per default only the following information is put onto your profile page:

• Your display name (or real name if you do not have a display name)

• Your pages that are visible to the person viewing your profile page

• Your groups

• Your wall

• Your friends

We advise you not to use your profile page as your portfolio because you cannot control who can look at the
information you make available on your profile. At minimum it is everybody who has an account on Mahara.
At maximum it can be everybody online. Always remember to think about your own personal security before
releasing contact information on a publicly available page or even just for other Mahara users.

Use regular pages to create your portfolio and your profile to make these pages accessible to other people and to
establish your digital identity.

Your Profile area (Content -> Profile) stores your contact and personal information. Each of the profile fields can
be considered separate artefacts which may be added independently to your profile page or any portfolio page.
Thus, you can reveal as little or as much information about yourself to others as you wish.

See Also:

You can edit your profile page like any other page in Mahara. You can find more information about editing a page
in the page editor.

3.1.1 About me

You must provide a first and last name. All other information is optional. You name is visible to other Mahara
users. You may choose to have a Display Name. You can change the information here at any time unless an
administrator locked certain fields.

• First Name: Your real given name

• Last Name: You real last name

• Student ID: Fill it in if it is required

• Display Name: The name by which you want to be known around Mahara. If you have a display name,
your real name will not be visible to regular Mahara users. Only administrators can see your real name and
your username at all times.

11
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• Introduction: You can write about yourself. This text is placed onto your profile page automatically unless
you take the introduction out of your profile page.

3.1.2 Contact information, Messaging, General

You may wish to provide some of your contact information for later use in a page. All details you fill in here are
only visible to other users when you put them into a page. Until then only you can see them.

The email address with which you registered on Mahara is displayed. You can add other email addresses to your
profile so that you can use them later on.

Note: When you add a new email address, make sure that you do not only click the Add button next to the field
where you enter your address, but also the Save Profile button at the bottom of the page. Once you have added an
email address, it needs to be verified. You will receive an email and need to follow the instructions to fully add
your address to your Mahara account.

If you use instant messaging services, you may wish to provide the details on those so that you can use them in
your portfolio later easily.

3.2 Profile Pictures

Your profile picture may be a picture of yourself or an avatar image of your choice.

3.2.1 Pictures uploaded to Mahara

You can upload up to 5 profile pictures into Content -> Profile Pictures. Alternatively, you can use a Gravatar if
you have one and if the site administrator allows its use.

The pictures you wish to use must be between 16x16 and 1024x1024 pixels in size. Ideally, your profile pictures
are square. Please use an image editing software before you upload your pictures to Mahara to reduce a photo’s
dimensions to the required ones.

Note: The recommended size of your profile pictures is 100x100 pixels. Then the picture looks good on your
profile when you want to include it there and also in the smaller sizes around Mahara.

The profile pictures that you wish to upload to Mahara must be available on your computer. Choose one picture at
a time to upload. You can also give it a title.

1. Click on the Browse button to navigate to your picture on your computer.

2. Click Open.

3. Optional: Enter a title for your picture.

4. Click Upload.

5. Your picture appears in the list of profile pictures and you can now choose it as default picture.

Note: Profile pictures can be used in an portfolio page, but they are not listed in the Files area.

When you have more than one profile picture uploaded, you can decide which one to make your default picture
that will appear around Mahara in user searches and in the Online users sidebar.

You can delete any of your profile pitures at any time. If you have 5 pictures uploaded and want to upload another
one, you have to remove one of the first 5.

12 Chapter 3. Content
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Figure 3.1: List your profile pictures

Note: Please make sure that you have the right to upload these pictures.

3.2.2 Remote avatars

If the site administrator allowed users to display remote avatars such as a Gravatar and you have signed up to that
service, your default picture will be this remote avatar until you make one of your uploaded pictures the default
picture.

3.3 Files

The Files area is a repository, i.e. a document storage for folders and files that you can use within your portfolio.
Both folders and files are considered artefacts and as such can be added to a page. You may create any number of
folders or sub folders. To view which sub folders and files sit within a folder, click on the folder name. Use the
Home link to return to the top level folder directory.

You can arrange files and folders by dragging and dropping the icon in front of the file / folder name onto another
folder icon. A suitably named and organised filing structure will help you with the long term organisation and
retrieval of your artefacts. If you want to move a file or folder out of a sub folder, move it onto the icon of parent
folder.

You will find that some folders are automatically created by the system such as viewfiles. This folder includes files
from imported pages. As with any other file, you can move them out of this folder and store them in a different
folder.

Note: You can move files and folders to your heart’s content without having to re-link them in the pages where
you use them. Also renaming them will not have a negative impact on links.

3.3. Files 13
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3.3.1 Upload a file

Before you upload a file, make sure that you are allowed to do so. For any artefacts that you publish in your
portfolio, you must have the sufficient rights. That means:

• the artefact is your own or

• you are allowed to reproduce and distribute it -> it does not violate any copyright legislation and

• the artefact also adheres to the Terms and Conditions of the Mahara site you are using

It can be that you have to agree to an upload agreement before you can upload any files to your files area. The
site administrator decides about that Site Administration -> Extensions -> Plugin Administration -> Plugin type:
artefact: file.

You can select a file from your computer to upload by clicking on the Browse button. Make sure that the file is not
larger than the allowed upload size.

When the file was uploaded successfully, it appears in your file list. You can edit it by clicking on the Edit button
to:

• change its file name (but leave the file extension)

• add a description which will help you to identify the file easily

• add tags which you can use to search your portfolio content

• allow comments directly on the artefact

1. Upload a file

2. Create a folder

3. Edit a file (continue with Step 5)

4. Delete the file

5. Change the name of the file

6. Give the file a description to find it again more easily

14 Chapter 3. Content
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7. Give the file one or more tags. You can choose from your existing tags if you wish. Separate your tags with
commas.

8. Decide if users should be allowed to comment directly on the file.

9. Save the changes

You can also move your file to a folder by clicking on the icon before the file’s name and then dragging and
dropping it onto a folder icon.

3.3.2 Upload multiple files

You cannot upload multiple files by simply selecting them. That is a Mahara 1.5 functionality. However, you can
place them all into a compressed file, a .zip file, and upload that to Mahara. Modern computers allow you to create
a zip file from any number of files that you have selected in your document managemant program by making a
right mouse click and selecting Compress... (or something similar).

Figure 3.2: Zip files in the Finder under MacOSX

Once you have uploaded your zip file to Mahara, you can unzip it there. Click on the Unzip button next to the

Edit button . Please follow the on-screen instructions.

3.3. Files 15
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Figure 3.3: Zip files in Ubuntu’s Nautilus

16 Chapter 3. Content
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Figure 3.4: Zip files in Windows Explorer

3.3.3 Create a folder

Type the name of the folder into the text field and click the Create folder button. You can edit the properties of the

folder by clicking on the Edit button . You can:

• change its name

• add a description which will help you to identify the folder easily

• add tags which you can use to search your portfolio content

• allow comments (this setting can be overwritten for the artefact on a page)

3.3.4 Delete a file or folder

You can delete a file or an entire folder and its content by clicking on the Delete button at the end of the line
of the file or folder.

If you use a file in a journal entry and / or on a page, you are warned before deleting the file so that you don’t
delete it by accident.

3.3.5 File quota

The site administrator of your Mahara site decides how much space you can have to store files. This can vary
across institutions. You can check your file quota in the sidebar in your ‘Files’ area.

3.3. Files 17
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Figure 3.5: File quota

3.4 Journal

The Journal is a tool with which you can record your thoughts and experiences online. By adding your journal or
individual posts of it to a page you can allow other users to place feedback and comments on it. Thus, you can
create a dialogue with your audience.

Per default, every user has one journal available.

Tip: If you wish to use more journals, e.g. to put your writing into categories so that you can make all posts from
one category available in a page without having to select each journal entry, you can go to your Settings and select
Enable multiple journals.

3.4.1 Change your journal settings

You can change the title of your default journal (and all others if you have enabled multiple journals) and add a
description as well as tags.

1. Click on the Settings button for your journal.

2. Change the title.

3. Add a description for your journal. You can format it as you wish.

4. Add tags to your journal for easier searching later on. Tags that you have already used elsewhere are
available to you under Show my tags.

5. Click Save Settings.

3.4.2 Add a journal entry

All journal entries you make are private to you until you put them into a page. Thus, the publishing of a journal /
journal entry is a three-step process:

1. You write your entry and save it.

2. In a page, you choose either the block for making the entire journal visible or just one post from a journal.

3. You give those who shall see that page access to it.

When you are ready to post your journal entry:

1. In your journal, click on New Entry.

2. Provide a title for your journal entry.

3. You must also write something in the Body. The visual editor helps you format your journal entry.

4. Add tags to your entry to find it more easily later on. You can choose from tags that you have already used
and / or enter new ones. Separate each tag with a comma. You may also choose tags from the ones that you
have created previously.
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5. Add an attachment or more to your journal entry, e.g. pdf files associated with it or images. You can add
files either from your files area or upload new ones directly onto your journal entry.

6. Mark your entry as draft if you have not yet finished it. This is especially helpful if you have published your
journal in a page, but do not want anybody to read this particular entry (yet). It is always visible to you, but
not others.

7. Allow comments if you want to receive them on the journal entry.

8. Save your entry.

3.4.3 Add a file as attachment to a journal entry

1. Click on the Add a file button and then Select the file(s) from your Files area that you wish to attach.

2. Alternatively, you can Upload additional files.

3. If you attached a file that you do not wish to attach anymore, you can Remove it.

4. Once you are done, you can click the Close button.

Figure 3.6: Attachments for journal entries

3.4.4 Add an image to a journal entry

You can add images to your journal entry in two ways:

1. Link to the image that is available elsewhere online.

2. Use an image that you have on Mahara.

Link to an image online

Images that are freely accessible online are easy to add to a journal entry. However, make sure that you have the
permission to use this image in your portfolio.

1. Go to the visual editor and click on the Image button .

2. Paste or type the image URL into the Image URL field. It must start with http:// or https://.

3. Provide a brief description for your image.

4. Select the alignment to the text for your image.
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5. Change the dimensions of your image if they are too large. If the image is recognised correctly, you have
the image’s dimensions displayed.

6. Add a border to your image if you wish to do so.

7. Add more space around the image by adding a number in Vertical space and / or Horizontal space.

8. Click the Insert button.

Figure 3.7: Link an external image in a journal post

Note: The dimensions are given in pixel. The first value is for the width and the second one for the height. Only
change one of the dimensions and delete the value from the second to retain the original proportions of the image.

If you are not happy with how the image looks in your journal entry, select it (it will get little square handles) and

click on the Image button again to make adjustments.

Add an image from Mahara

1. Attach the image to your journal entry.

2. Go to the visual editor and click on the Image button .

3. Choose the image from the drop-down list Attached image.

4. Provide a description for your image.

5. Select the alignment to the text for your image.

6. Change the dimensions of your image if they are too large. IF the image is recognised correctly, you have
the image’s dimensions displayed.
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7. Add a border to your image if you wish to do so.

8. Add more space around the image by adding a number in Vertical space and / or Horizontal space.

9. Click on the Insert button.

If you are not happy with the alignment or the dimensions of the image in your journal entry, select it and click on

the Image button again to make adjustments.

3.5 Résumé

The résumé plugin allows you to create an online résumé / curriculum vitae. You can either publish the entire
résumé or individual components of it in your portfolio.

3.5.1 Introduction

In the introduction you can write a Cover Letter and also provide some Personal Information.

Write your cover letter

It is advisable that you write your cover letter in a word processor. That will allow you to spellcheck your writing.
Alternatively, a site administrator could install the spellchecker for the editor.

However, you should do the formatting in the editor window and not your word processor to avoid unwelcome
formatting changes.

Click the Save button right below the editor window when you are happy with your cover letter to save it to Mahara
for future use.

Note: If you write your cover letter or any other text in Microsoft Word, please use the Paste from Word button

to strip out most of the formatting code that Word puts into a document but can interfere online.

Provide personal information

None of the fields under Personal Information are required. You can choose to include as much or as little
information as you wish. Most fields are free form fields.

Note: Mahara is being used around the world. Therefore, some information here or later on in the résumé do not
apply to you. If you do not need them, you do not have to fill in the fields.

• Date of birth: Either choose your date of birth from the calendar or enter it in the format YYYY/MM/DD,
e.g. 1978/01/30 when you want to say that you were born on 30 January 1978.

• Place of birth: Enter your place of birth. You can also enter the country you were born in.

• Citizenship: Fill it in as it is shown in your passport.

• Visa status: As employment laws vary between countries, you may wish to include your work or travel visa
status within your résumé where relevant.

• Gender: Select the one that applies to you.

• Marital status: Provide it if it is relevant.

Click on Save when you want to keep that information.

3.5. Résumé 21



Mahara Documentation, Release 1.4

3.5.2 Education & Employment

This part of the résumé allows you to create a record of your academic and professional qualifications as well as
your work experience.

The process of creating an entry for your education history and your employment history is similar. Therefore, the
process is explained only once.

1. Click the Add button to start a new entry.

2. Fill in all the fields that are marked in red and with an *. These fields are required to have a minimum of
information.

3. Fill in the other fields if they are relevant for you.

4. Click the Save button right below the “Qualification Description” to save your entry.

5. Click the Add button to add more items.

Note: You can enter the dates any which way you wish. It is not a calendar date field because different résumés
require different date formats.

Figure 3.8: Interpreting the Education History table

1. Use the up and down arrows to change the order of the individual items in your history.

2. The start date is displayed as you entered it.

3. The end date is displayed as you entered it.

4. Your qualification along with the institution is shown.

5. Use the Edit and Delete buttons to edit the individual records or delete them respectively.

Note: It is important to save each new entry using the Save button at the end of the form.

Entries are displayed in a tabular format. Change an entry by clicking the Edit button . When you are finished,

save your changes to return to this page. Click the Delete button to remove entries.

If you have provided a description for your qualification, click your qualification’s name to view or hide this
information.

3.5.3 Achievements

In Achievements you can collect information on:
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• certifications, accreditations and awards, e.g. Chartered Accountant, Registered Nurse, Award for Best
Actress

• books and publications

• professional membership, e.g. in the American Philosophical Society

The process of adding, editing and moving entries is similar to the process for Education & Employment.

1. Click the Add button to start a new entry.

2. Fill in all the fields that are marked in red and with an *. These fields are required to have a minimum of
information.

3. Fill in the other fields if they are relevant for you.

4. Click the Save button right below the “Description” to save your entry.

5. Click the Add button to add more items.

6. Use the up and down arrows to change the order of the individual items in your history.

7. Click the Delete button to remove an entry from your list.

Figure 3.9: Achievements provided in the Résumé

Note: Click the title of your certification, accredidation, award, book or professional membership to see its full
description.

3.5.4 Goals

The Goals area is divided into three sections:
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• Personal goals

• Academic goals

• Career goals

Goals added here may be included in your portfolio pages.

Personal or career goals are often provided in résumés so that employers can understand how a particular role
might suit your ambitions.

You can also use the academic goals section to describe achievements you are seeking in your programme of
study.

Write your goal description into the appropriate box and click on the Save button once you are done editing. You
can come back at any time and edit your goals.

Figure 3.10: Writing down goals for use in portfolio pages

3.5.5 Skills

The Skills area is divided into three sections:

• Personal skills

• Academic skills

• Work skills

Skills added here may be included in your portfolio pages.

Employers are always interested in what skills you can bring to a role. You can also use this section to display the
attributes that you would bring to a collaborative community or working group.

Write your skills descriptions into the appropriate box and click on the Save button once you are done editing.
You can come back at any time and edit your goals.

3.5.6 Interests

The Interests section allows you to list your personal and / or professional interests. This might include your
hobbies, sporting activities, volunteer work, areas of research and expertise etc. Listing your Interests will help
employers form a better picture of who you are and what you would bring to their organisation.

Write your interests into the editor window and click on the Save button once you are done editing. You can come
back at any time and edit your interests.
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Figure 3.11: Example of work skills

Figure 3.12: Example of interests for a résumé
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3.6 Plans

Plans are simple ToDo lists. They are particularly well-suited to plan medium and long-term endeavours. A plan
can consist of a number of individual activities with which completion dates are associated.

3.6.1 Create a new plan

1. Go to Content -> Plans.

2. Click the Create new plan button.

3. Give your plan a title.

4. Give your plan a description. It is visible when you select a plan for inclusion into a portfolio page.

5. Click Save plan.

Now you can add individual tasks to your plan.

3.6.2 Add tasks to a plan

There are several ways to add a task to a plan:

• Click on Add task right after you saved your plan.

• Click on Content -> Plans -> the title of the plan -> New task.

• Click on Content -> Plans -> the Manage tasks button -> New task.

Once you are in the New task screen, you can create your new task:

1. Enter a title for your task.

2. Provide a completion date. This is compulsory and allows for tasks to be marked overdue.

3. You can provide more detailed information about the task in the Description field.

4. If you have already completed the task, you can tick the checkbox.

5. Click Save task.

6. Add more tasks or come back to them later.

Figure 3.13: Plans under Content
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Figure 3.14: That’s what a plan looks like in a portfolio page. Clicking on the title of the task shows / hides the
task description.

3.6.3 Edit tasks in a plan

1. Click on Content -> Plans -> the Manage tasks button or the title of the plan.

2. Click on the Edit button next to a task that you want to change.

3. Make your changes or mark a task as completed.

4. Click Save task and your changes are recorded.

The Content tab holds all artefacts that you can create or upload for use in your portfolio. All information and
files you provide here are initially only visible to you. Exceptions are:

• your display name or if you don’t have one your real name

• your profile picture

Both these are visible in the Online Users side bar if that is activated. Your display name, but not your profile
picture, is also visible on your profile page per default.

Only when you put artefacts into your portfolio pages or share them in a group will they be visible to others.
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CHAPTER

FOUR

PORTFOLIO

4.1 Pages

A page contains a selection of artefacts which you arrange and present to others. These may include:

• selected files

• résumé details

• text (your added commentary, instructions or orientation)

• journal posts

• video and audio files

• RSS feed to an external blog

• etc.

You can re-use the artefacts that you collected under Content in as many pages as you wish.

4.1.1 Overview page

On the landing page of the portfolio, you can do the following:

1. Create a new page.

2. Copy a page from your portfolio or from another user.

3. Search your portfolio pages.

4. Edit your dashboard page.

5. Edit your profile page.

6. Edit or delete your portfolio pages.

4.1.2 Create a new page

You create a new page in your portfolio when you want to display artefacts together, e.g. for presenting it to others,
for showing your progress in a project etc.

1. On the Pages page, click the Create Page button. You are taken to the page editor.

2. Decide what type of artefact you wish to display in your page.

3. Choose the desired artefact block and drag it into the content editor area.

4. Follow the on-screen instructions for selecting the content you wish to display and click the Save button.

5. Choose further artefact blocks and configure them.

6. Cick on the tab Edit Title and Description to give your page a title, description, and tags.
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Figure 4.1: The same artefacts can appear in multiple pages

Figure 4.2: The landing page of your portfolio

30 Chapter 4. Portfolio



Mahara Documentation, Release 1.4

7. Click the Save button to return to the page editor.

8. Click the tab Edit Layout to change the layout for your page from the standard 3 columns to 2 columns or
another choice.

9. Click the Save button to return to the editor.

10. Click the Done button at the bottom of the page to finish editing this page. You are taken back to the
overview page.

See Also:

See Page editor for detailed information on the individual elements of the editor.

Figure 4.3: An example portfolio page. When you are the author, you can click on the Edit button and make
changes.

The individual elements in the screenshot are the following:

1. Title of the portfolio.

2. Author of the portfolio page.

3. Description of the page.

4. The Edit this page button is only visible to the portfolio author.

5. The artefacts that have been placed in the page.

6. Feedback area at the bottom of each page displays comments from users.

7. Place feeback button can be used by yourself and others to leave comments on the page.

8. If a page contains offensive artefacts, users can report that to the administrator.

9. Print button to print the page.

10. The Add page to watchlist allows you be informed when changes are made to the page.
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4.1.3 Edit a page

You can edit an existing page in two ways:

1. Click on the Edit button when you are on the Pages overview page.

2. Click on the Edit this page button when you are on the actual page.

Warning: Text boxes and links to external content such as embedded external videos and RSS feeds to an
external blog are completely deleted when you remove the respective blocks from your portfolio page. You
cannot recover them. There is no revision history. All other artefacts are not deleted when you remove them
from a page because they reside in your Content area.

4.1.4 View a page

You can view a page to check what it looks like when somebody else sees it. Go to the Pages overview page and
click on the title of a page.

At the bottom of any page (except the profile page) that you have access to you can perform a number of actions.

Figure 4.4: Actions at the bottom of a page

1. Place feedback for the page or artefact author.

2. Report objectionable content to the administrators, e.g. when content on the page does not comply with the
terms and conditions of the page, is offensive etc.

3. Print the page.

4. Add the page to your watchlist and receive notifications when the content of the page changes.

5. View the number of comments that have been left on the page.

4.1.5 Give others access to your page

See Also:

Please refer to the section on sharing your pages and collections for further information.

4.2 Page editor

The page editor is important in Mahara because it allows you to compose your portfolio pages. It consists of a
large number of components:

1. Editor navigation

2. Artefact chooser

3. Page layout area
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4.2.1 Editor navigation

Figure 4.5: Page editor navigation bar

• Edit Content: Place your content on a page. See Artefact chooser, Blocks and Page layout area.

• Edit Title and Description: Add and modify your page title, description and tags.

• Edit Layout: Change the overall layout of your page.

• Display page: Preview your page to see how others would see it.

• Share page: Decide who shall have access to your page. See Share for more details.

Edit title and description

You should give your portfolio page a unique title so that you can find it again later on. The description helps you
to see quickly on the overview page why you have created this page. Furthermore, the tags help you to search
your portfolio for these keywords and find your content and portfolio pages.

Figure 4.6: Provide as much information as possible to distinguish and to be able to search your portfolio later on.
You can make changes to these settings at any time.

1. Page Title: You must provide a title for your page. Automatically, every page is called “Untitled”.

2. Page Description: You can write a brief description for your page, e.g. its purpose. this description is
displayed on the overview page and on the portfolio page itself.

3. Tags: If you have already tagged artefacts or other portfolio pages, you can choose from your existing tags.
This makes it easy to avoid spelling mistakes.

4. If you either do not yet have tags or need to use a new ones, you can write them into the text box. Separate
multiple tags by commas.

5. Name display format: You must choose which name should be displayed when somebody else views your
portfolio.

6. Click the Save button to save your changes.
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Edit layout

You have 10 choices for your column layout from 1 column to 5 columns. The 2-, 3- and 4-column layout options
allow you to make certain columns wider than others. The icons assist you in your decision of what the end result
looks like. However, you cannot set a specific width of a column.

Note: Be careful when choosing 4 or more columns. Your portfolio page may look very good on your big 21”
screen, but a user looking at it on a notebook or tablet may not have the same experience. In most cases, up to 3
columns are the best choices.

Click the radio button above the layout that you wish to apply to your page. You can change it at any time. When
you reduce the number of columns, your blocks simply move to the first column. You can then move them around
to their correct position (see Page layout area).

Figure 4.7: Edit the overall layout of a page by choosing the number of columns

Note: You can add or remove columns directly in the page layout area when you enable the Show controls to add
and remove columns when editing a page setting in your account options.

4.2.2 Artefact chooser

All different types of artefacts as well as blocks that pull in external content into a portfolio page are accessible
via the artefact chooser.

• External content: contains blocks to place RSS feeds, external media or GoogleApps documents etc. into
a page
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Figure 4.8: You can use the Add and Remove buttons for quick changes to the layout when you have enabled them.

Figure 4.9: All artefacts are accessible via a number of tabs in the page editor

• Files, images and video: holds blocks for Mahara files that can be displayed as links, in folders, or in the
case of images and videos directly in the page

• General: artefacts that are of a general nature

• Journals: various artefact blocks which allow you to place journals / journal entries into a page

• Profile: choose profile information to display in a block

• Résumé: display your entire résumé or only parts of it

See Also:

The functionality of each block that you can use in your portfolio pages and in group pages, is outlined in the
section on the individual artefact blocks.

4.2.3 Page layout area

The page layout area is the place where you arrange all your artefacts for display in a portfolio page. You should
know the following about this area:

• All artefacts are placed into it by dragging and dropping their blocks into this space.

• The artefacts are arranged as a series of contiuous blocks per column.

• There are now rows, only columns. Blocks are place beneath each other within a column, but they never
align with blocks in another column to form a single row unless they have the same height.

• You can drag and drop blocks by clicking on their headings.

• You can change the settings of a block by clicking on its Configure button .

1. Click on the block of the artefact that you want to include in your page and drag it into the page layout area.

2. When you see the dotted rectangle, drop the block into it to put it onto your page.

3. Follow the on-screen instructions on choosing the specific artefact you wish to display. Please refer to the
artefact block for more information on each block’s settings.
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Figure 4.10: Drag and block into the page layout area and configure its settings
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See Also:

Please refer to the section edit layout to learn how to change the number of columns on a page and make certain
columns wider than others.

4.2.4 Optional theme chooser

You may be able to choose a theme for your portfolio page. If that is the case, you see a Theme drop-down menu
below the artefact chooser. That allows you to select a theme in which that page is displayed to others who view
your portfolio page.

Figure 4.11: Select a theme for your page

See Also:

The site administrator must allow page themes in the site’s user settings.

4.3 Collections

A collection is a set of pages that are linked to one another and have the same access permissions. You can create
as many collections as you like, but a page cannot appear in more than one collection.

4.3.1 Add a collection

You add a collection under Portfolio -> Collections.

1. Click the New Collection button.

2. On the next screen, provide a title for your collection.

3. Optionally, you can also write a short description about your collection. You do not have a visual editor, but
just a plain text box.

4. Choose whether you wish to display a tabbed navigation or not. If you choose not to, you will have to
include the navigation block so that you can go from one page to the next.

5. Click the Next: Edit Collection pages button.

4.3.2 Edit collection pages

In the next step after you have created your collection, you choose which portfolio pages you wish to include in
this collection. You see all the pages that you can use potentially. If you had already placed a page into another
collection, it is not an option here.
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Figure 4.12: Create a collection

Figure 4.13: Add pages to a collection
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1. Put a check mark next to each page that you wish to include in your collection.

2. Click the Add pages button to add the pages to your collection.

3. Click the Done button to finish this step.

4.3.3 Manage collection pages

Once you have added your pages to your collection. You can move them around or remove them.

Figure 4.14: Manage the pages that are displayed within your collection

1. Use the move up and move down buttons to arrange your pages in a different order.

2. Click the Remove button to take a page out of a collection. The page itself is not deleted.

3. Click the Save button.

You can add more pages to a collection from the Add pages to collection box.

Figure 4.15: A collection with the tabbed navigation

4.3.4 Manage your collections

On the overview page of the collections, you can:

1. Create a new collection by clicking on the New Collection button.

2. Click on the collection title to go to the first page of a collection.
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3. Click on any title of a page within a collection to jump directly to it.

4. Click on the Manage button to move pages within a collection, add to or delete pages from a collection.

5. Click on the Edit button to change the title and description of a collection.

6. click on the Delete button to delete the collection. The pages will still exist.

Figure 4.16: Collections overview page

4.3.5 Give others access to your collection

See Also:

Please refer to the section on sharing your pages and collections for further information.

4.4 Share

When you have created portfolio pages (and collections), you may wish to share them with others, e.g. to receive
feedback. You can set the access permissions on the Edit access page. It is accessible via Portfolio -> Share or
directly from the page editor when you edit a portfolio page.

The Share overview page shows you the following:

1. Your collections and pages sorted alphabetically.

2. The list of users and or groups who have access to a particular collection or page.

3. The Edit Access button which allows you to change the permission of who can view a page or collection.

4. The Secret URL edit button which allows you to set up one or more secret URLs for a page or collection.
The number of secret URLs that you have generated is displayed next to the button.

4.4.1 Edit access for users with an account

The Edit Access page allows you to set the permissions for a single user or multiple users for if and when they
should be able to view your portfolio pages or collections.

You can assign access to a single page or collection at a time or to multiple pages and / or collection at once.

You have a number of choices of selecting who shall be able to see what:

1. Choose the collection or collections for which you want to give access. If you made a mistake in your
selection, either take the checkmark off or select All or None to check or clear all respectively.
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Figure 4.17: Share overview page

2. Choose the page or pages for which you want to give access. If you made a mistake in your selection, either
take the checkmark off or select All or None to check or clear all respectively.

3. Public: anybody online who knows the URL(s) can see your selection of pages / collections.

4. Logged-in users: all users who have an account on the Mahara instance you are using can view your
selection of pages / collections.

5. Friends: all your friends on Mahara can view your selection of pages / collections.

6. All my groups: every member in the groups to whom you belong can view your selection of pages /
collections.

7. A particular group: all members of that group can view your selection of pages / collections.

8. If none of the above choices are what you are looking for, you can search for specific users or groups. Make
your selection.

9. Type the name of the user or the name of the group you search for. A partial name is often best.

10. Add the user or group. You can click on the name of the user or group to verify that it is the correct one.

Note: Your friends or individual users with whom you shared your pages / collections receive a notification.
Group members also receive a notification that you shared a page with them if the group administrator allowed
that. You do not receive a notification when a user shared his page with the public or al logged-in users.

4.4.2 Restrict access based on time

In addition to controlling who shall have access to your pages / collections, you can further restrict that access for
a specific period of time.

1. Each user or group of people can receive their own time restrictions that are independent of other access
groups. You can specify a start date.

2. You can also specify an end date.

3. You can click the Remove button to completely take a user group off your access list.

4.4.3 Choose advanced options

You can choose a number of additional options which are applied to all pages and / or collections that are selected.

1. Allow comments: This check box is selected by default to encourage you to allow others to comment on
your pages.
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Figure 4.18: Users and groups to whom you can give access to pages and / or collections

Figure 4.19: Restrict access to your pages / collections further
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Figure 4.20: Advanced options for editing access to pages / collections

2. Moderate comments: If you wish to see any comment before it is made public, i.e. can be see by others
who have access to the page on which the comment is made, place a check mark here.

3. Allow copying: Place a check mark in this box if you want to allow the users who can view your page
to make a copy of it for themselves. Any text box content, files and folders will be transferred to their
portfolio. For journals you decide whether they can copy them or not. Profile information, plans and
résumé information are not copied.

4. Overriding Start / stop dates: Here you set the time frame for when all users who have access to your
page / collection can view your page. The dates here override any individual dates you may have set.

If you have not allowed copying in general, you can still choose to allow comments for a certain person or group
of people who are in your access list. That way you can regulate very flexibly who shall be able to place comments
on a page / collection and who cannot.

Figure 4.21: Allow comments on a user-by-user basis

Todo

Check which blocks can be copied and which ones cannot.

Note: If you edit an institution page, you see an additional option when you allowed copying. With this option
you can place a page directly into the portfolio of a new user. Existing users still have to copy the page themselves.
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4.4.4 Edit access for users with no account

Besides giving users who have a login or the entire public access to your portfolio, you can also give users who
do not have an account on Mahara access to your portfolio pages and / or collections without making your work
publicly available and searchable by search engines. This can be interesting, e.g.

• when you create a portfolio for a job application and the prospective employer does not have a login and
cannot get one.

• when you want to share your portfolio with your parents and also get feedback from them.

• when an external assessor shall evaluate your work.

You can create a secret URL the following way when you are on the share overview page and click on the Edit

button :

1. Click the Add button to generate a new secret URL.

2. You can now copy this URL and put it into an email to send to somebody.

3. You can click on the Edit button to add a time restriction for access to your page / portfolio via this
URL and then click the Save button.

4. Click on the Delete button if you do not want to use this secret URL anymore.

5. Click on the Add button to generate another secret URL for this page to which you can assign different time
restrictions.

Figure 4.22: Add one or more secret URLs to a page or collection

Note: Logged-out users or those who do not have an account can only leave comments on public pages or pages
which they can access via a secret URL if the site administrator turned on the Anonymous Comments function
under Site Administration -> Configure Site -> User Settings.

4.5 Export

You can export your portfolio to keep your files and Mahara-created content offline. You have two options for the
export. Both are downloaded as zip file which you can then uncompress in the case of the HTML web site:

• HTML web site: A self-contained web site with your portfolio data is created. You cannot import this into
Mahara or another portfolio system again, but it is readable in a standard web browser and you do not need
a Mahara in order to view it.

• Leap2A: A zip file containing a folder in the Leap2A standard format is created. You can then import this
into another Leap2A-compliant system or have it imported by an administrator into your current Mahara or
another one. A new user is created during the import process.

Note: It is recommended that you export your portfolio both in HTML and Leap2A because you never know
whether you will be able to import it back into Mahara or maybe even another ePortfolio system.
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To export your portfolio:

1. Go to Portfolio -> Export.

2. Choose either Standalone HTML Website or Leap2A. You can run through the export twice in order to get
both formats.

3. Choose what you want to export:

• All my data: Everything that is stored in your account in Content and Portfolio. Excluded are any
group contributions.

• Just some of my pages: You can then choose which pages and the artefacts that go with it you want
to export.

• Just some of my collections: You can select which collections and their artefacts you want to export.

4. If you have chosen to just export some pages or collections, you can select them here. You may also preview
a page first.

5. Click the Generate export button to start the export process.

Depending on the size of your portfolio, the export may take a little bit. Once everything has been processed, a
file will either be downloaded automatically to your computer or you can decide to save it. That depends on your
browser settings.

Note: If your export gets stuck in the process and the progress bar does not move along at all, your server settings
may prevent long operations to avoid slowing down. You will need to contact your site administrator, e.g. via the
“Contact Us” form in the footer of your Mahara instance.
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4.6 Feedback

Giving feedback is an essential component for portfolio work. You can give feedback not only on individual
artefacts but on entire portfolio pages.

The author of a file or portfolio page decides whether you should be able to leave comments or not. For files, the
comments option can be found when uploading or editing a file and for pages in the advanced options.

When the author of a page allows it, you can provide feedback on the page or artefact to which you have access.

Figure 4.23: Provide feedback

1. Click the Place feedback link at the bottom of the portfolio page or the details page of an artefact for which
you want to write feedback.

2. Write your feedback into the editor window.

3. If the site administrator turned on comment ratings, you can use the 5-star rating scale in addition to your
written comments and / or an uploaded file.

4. Enable the Make public check box when you want everyone who has access to this page to see your
comment. If you do not make your feedback public, only you and the page author can see your comment.

5. Click the Browse button to attach a feedback file from your computer. This file is place into the files area of
the author of the page.

6. Click the Place feedback button to save your feedback to the page.

7. Click the Cancel button to abort your changes.

8. Once you have placed feedback on the page, the author receives a notification about it.

Note: Feedback writers do not receive notifications about additional comments made.

4.7 Feedback for assessment

4.7.1 Submit a page for assessment

When you are a member of a course controlled group, you can submit portfolio pages for feedback / assessment
and lock much of your content.
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Figure 4.24: Submit a page to a course controlled group

1. Go to the group homepage of the group in which you want to submit a page and choose it from the drop-
down menu under Submit a page to this group.

2. Click the Submit button to lock page content.

You do not have to give the group permission to access your page. When you submit your page, the group
administrators and tutors are able to see them and give you feedback. Other group members do not see your page.

During the feedback phase, you cannot make any changes to

• files

• journal posts

• text boxes

• links to external content

You can still edit

• plans

• profile information

• résumé information

4.7.2 Instructor feedback

Once a page is submitted for feedback in a course controlled group, you can give feedback on it without the
other user being able to change much of his page content. You see all submitted pages on the group’s homepage
including a time stamp.

Figure 4.25: Submitted page with time stamp

You can now give feedback on that page and then click on the Release page button so that the other user can
continue working on this page.

4.8 Tags

Tags are keywords that you can give to artefacts and pages in your portfolio to find them more easily later on.

Note: A site administrator must have the tag cloud enabled for you to use this feature.
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4.8.1 Tag cloud

You can see your tag cloud in the sidebar when you are in the Content and Portfolio areas. Configure how many
different tags you wish to display in your tag cloud in your account settings.

Figure 4.26: Tag cloud

1. Click on the Tags heading to be taken to all your tags.

2. Click on any tag to see all artefacts and pages from your portfolio area that have this tag associated.

Note: The more you use a tag for your files, journal entries and pages, the bigger its font size in the tag cloud.

4.8.2 My tags

On the My tags page you see all your tags and the artefacts and pages associated with them. You have a number
of filter options to show only the resources that you wish to see.

Figure 4.27: My tags overview page

1. The default view is to sort your tags alphabetically. Capitalised tags are treated before non-capitalised tags.

2. You can also sort tags by frequency showing the most frequently used tags first.
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3. You can click on any tag and filter the artefacts and pages you have according to them. The number in
parentheses tells you how many times a tag occurs in your resources.

4. The filter term is repeated.

5. You can sort the results by their title or date.

6. You can filter your results by specific artefact types or just show portfolio pages.

7. The title of a resource, its description if available and its associated tags are displayed.

8. The creation date and time as well as the type of resource is shown.

9. Click the Edit tags button to make changes to your tags.

4.8.3 Edit tags

You can edit your tags to correct spelling mistakes or delete a tag.

Figure 4.28: Edit your tags

1. Select the tag that you want to edit.

2. Once you have selected your tag, it is highlighted in bold in the list and two new boxes appear. You can
provide the new name for your tag under Name.

3. Click the Submit button to save your change.

4. Alternatively, click the Delete button to delete this tag.

5. You can also click on the My tags button to be taken back to the overview page of all your tags and their
associated resources.

The Portfolio is the place in Mahara where you assemble the artefacts that you collect in Content into pages. You
can then share these pages with others or simply keep them for yourself.

In this section you learn how to:

• create portfolio pages

• create collections to bundle portfolio pages

• share your pages and / or collections

• export your portfolio

• give feedback on artefacts and pages

• view your tag cloud and change tags
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FIVE

GROUPS

5.1 My groups

This page lists the groups you are related to in some way. You can see the groups you own or are a member of, as
well as groups you have been invited to or have asked to join.

If your site administrator allowed you to create groups yourself, you see the Create Group button.

Figure 5.1: The My Groups page lists all your groups

1. Choose the filter you wish to apply to view only a subset of your groups and then click the Filter button.
You can filter for:

• All your groups

• Groups you own

• Groups you are a member of

• Groups you are invited to

• Groups you want to join

2. Click the Create Group button when you want to set up a new group.

3. If you are a member of a controlled membership group, you cannot leave the group. You can leave other
groups that are not controlled at any time.

4. Click the Accept or Decline button to join an invite group or to decline membership in that group.

5. Click the Edit button when you want to update the details for your group. Click the Delete button only when
you want to delete your group permanently.
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In addition to the filter options above, you can filter for group categories if the site administrator allowed them
and had them set up.

Figure 5.2: Filter your search results according to a group category

Warning: When you delete a group, all its content and contributions from users are gone and cannot be
retrieved again.

5.2 Find groups

You see all groups that exist on Mahara and get basic information about the groups.

Figure 5.3: A list of all groups on Mahara and certain actions you can perform

1. Search for a certain group using a word from the title or description. You can search either all groups,
groups you are a member of or groups you are not in.

2. If you want to become a member of an open group, click the Join this group button and you will be a
member immediately.

3. If you have been invited to a group, either Accept or Decline the membership invitation.

4. If you want to join a group that needs the approval of the group administrator first, click the Request to join
this group button next to the group.

5. You can also find out more about a group by
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• clicking on the group name to see the group homepage

• clicking on the name of the group administrator to get to his profile page

• clicking on the member link to see who is already a member of this group

In addition to the filter options above, you can filter for group categories if the site administrator allowed them
and had them set up.

Figure 5.4: Filter your search results according to a group category

Note: Usually, you do not see forums, group pages and group files unless you are a member of a group. If a
group is publicly available, you do see the forum discussions.

5.3 Set up a group

You can create a number of different groups depending on your role on Mahara.

• All user roles

– Open membership: Any user of the site can become a member simply by visiting your group page
and clicking the Join button.

– Request membership Any user can request to join your group. However, as owner you can choose to
accept or decline this request. The requesting member will be notified of your decision automatically.

– Invite only: Only users that you explicitely invite may join your group. They can accept or decline
your invitation.

• Staff and administrators

– Standard controlled membership

* You can add users directly to your group.

* The members cannot leave this group.

– Course controlled membership

* You can add users directly to your group.

* The members cannot leave this group.

* You can assign tutors to the group. They can only add new members.

* Group members can submit portfolio pages for feedback / assessment. These pages are locked
until released by an admin or tutor.

– Course request membership

* Any user can request to join your group. However, as owner you can choose to accept or decline
this request.
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* The members can leave this group.

* You can assign tutors to the group. They can only add new members.

* Group members can submit portfolio pages for feedback / assessment. These pages are locked
until released by an admin or tutor.

* This group is designed to be used for a course-based group where the membership is defined
by an external system (such as an institution’s enrolment system) and you wish to replicate that
membership in the group. However, you can also set up this group manually.

Note: The site administrator can limit the creation of groups to users with staff and / or administrator rights. If
you cannot create a group, you will most likely not have the appropriate permission and will have to contact your
site administrator, e.g. via the Contact us form to enquire about the process of having a group set up.

5.3.1 Create a group as a user, staff or institution admin

If you are allowed to create a group, you see the Create Group button on the My Groups overview page.

Figure 5.5: Create a group as a user

1. Click the Create Group button on Groups -> My Groups.

2. Group name: Provide a name for your group. You must fill in this field.

3. Group description: Briefly describe what your group is about.

4. Group type: Choose a type for your group. For descriptions of the types and what user role can create
which group type, see above.

5. Group category: Choose a category if you want to associate your group to one, allowing you to filter groups
on the My Groups and Find Groups page. This setting is only available if the site administrator turned it on.
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6. Publicly viewable group? Choose this option if anybody shall have access to this group. You only see this
setting if the site administrator allowed you to have it. Anybody can see the group homepage, the members
and the discussion forum. Only members of the groups can see the group’s pages, unless they have been
made public, and the files area.

7. Shared page notification: This check box has a check mark per default. Whenever somebody shares a
page with the group, all group members get an email. You may want to uncheck this setting in very large
groups where lots of pages get shared but members do not have to be notified.

8. Click the Save Group button to finish creating your group, or click the Cancel button to abort the group
creation process.

Note: The group name that you choose does not have to be unique. Other groups can have the same name. In
order to distinguish them more easily, you can add a group description.

5.3.2 Create a group as a site admin

When you have site admin rights, you have an additional setting when you create a group: You can choose to add
new users to a group automatically. That way, any new user who creates an account after the group is created
becomes a member of this group.

Figure 5.6: Add users to a group automatically.

Note: This is a great setting when you want to set up a community group which all users should join in order to
participate in forum discussions etc. On mahara.org this is used to make every user a member of the “Community”
group in which discussions around Mahara take place.

All other group settings still apply.

5.3.3 Edit general group settings

You can start out editing a group’s settings from three places by clicking on the Edit button:

• My Groups overview page
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• Find Groups page

• The group homepage

You are then taken to the same screen as if you were creating a group and make the necessary changes.

Warning: You can change the group type to a different one. Please be careful if you do so especially from a
controlled course group. If users have submitted portfolio pages to that group, they remain locked eve when
you change the group type.

5.4 Inside a group

Note: It depends on your role in the group whether you can access / change certain functionalities that you see in
the screenshots and described in the text.

5.4.1 Group homepage

The group homepage is the central space for a group. There you can get a quick overview of the group and reach
all the places that you wish to take a look at in a group. You see a few things per default on the group homepage.

Figure 5.7: Group homepage for an “Invite only” group

1. Group name

2. If you are a member in the group, you see your status and whether you can leave the group or not. If you
are an admin of the group, you see the Edit and Delete buttons.

3. Group navigation

4. Basic information about this group:
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• Group administrators so that you can contact them easily

• Group type

• Creation date of the group

• statistics on the number of group members, pages, files and folders

5. Latest forum posts and a link to the forums

6. Group members and a link to the full list

If you are a group administrator, you can put other blocks on the group homepage. Check the blocks in pages
context for a list of them.

5.4.2 Members

On the group members page, a group admin can

• invite multiple users to the group at once or add multiple users in bulk if it is a invite or controlled member-
ship group.

• search for group members

• view basic information about group members like

– their name

– their role

– their profile introduction

– their group joining date

• change the role of a user

• remove a user from the group

Figure 5.8: Group members page as seen by a group administrator

If you are not a group admin, you are not able to invite or add people from the members page and you cannot
change the role or remove a user from a group.

5.4.3 Forums

The forums are visible to all group members. If you created a public group, anybody online would be able to see
the forum discussions. However, they would need to log in to participate. Forums in public groups receive an RSS
feed so that users can subscribe to them, e.g. the mahara.org community forums.

1. If you have appropriate rights, you can create a new forum by clicking on the New forum button.

2. Name and brief description of the forum
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Figure 5.9: Group forum overview page

3. Forum administrators and moderators (if appointed)

4. Number of forum topics

5. Unsubscribe / Subscribe button if the forum admin allowed for this option

6. Edit button for making changes to the forum settings for group admins and moderators Delete button

for making changes to the forum settings for group admins and moderators

Set up a new forum

A group administrator can set up forums in a group.

Figure 5.10: Basic set up of a forum

1. Click on the New forum button to set up a new forum.

2. Title: Give your new forum a title.

3. Description: Write a brief description of your forum. This will appear when the forum is listed under the
Forum tab making it easier for users to decide whether they want to look at it or not.

4. Forum indent mode: Specify how the topics in this forum should be indented.

• Fully expand: Indentation is used to indicate the replies to individual posts. There is no limit to the
level of indentation.
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• Expand to max: Indentation to indicate the replies to individual post specifying the maximum level of
indentation (pops up once this option is chosen). All replies beyond the chosen level are not indented
further.

• No indents: There is no indentation of replies to individual posts, but the forum structure is flat.

5. Click the Save button to make these changes or continue on to the Settings.

Besides these basic settings, there are additional ones that the administrator can decide on.

Figure 5.11: Choose further settings in the forum

1. Automatically subscribe users? Choose whether group users will be subscribed to this forum automati-
cally. When subscribed, users will receive notifications when new posts and replies are made in the forum.
Users will have the option to unsubscribe if they do not want to be notified.

2. Order: A default position for your forum is chosen upon its creation - after the last existing forum. Here
you may position it elsewhere in the list of forums. Click the radio button above or below a certain forum
to position it before or after it.

3. Moderators: Choose one or more moderators for your forum. They can edit and delete topics and posts as
well as open, close, set and unset topics as sticky. Thus, they can perform some administrative functions
without having to receive full administrator rights.

(a) Select one or more users from the list of Potential moderators on the left or search for a person.

(b) Click the right-arrow button to add the user(s) to the Current moderators.
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(c) To remove a moderator, select the user in the Current Moderators list on the right and click the left-

arrow button to remove this user.

4. Who can create topics: Decide who in your group is allowed to create topics within a forum. If set to “All
group members”, any group member can create new topics and reply to existing topics. If set to “Moderators
and group admins”, only moderators and group administrators can start new topics, but once topics exist,
all users can post replies to them.

5. Close new topics: If checked, all new topics in this forum will be closed by default. Only moderators and
group administrators can reply to closed topics. This is a setting that may be useful for a forum that is solely
used for announcements.

6. Click the Save button to save the settings for the forum or use click the Cancel button to retain the previous
settings.

Add a forum topic

When you have the right to add a forum topic, you see the New topic button when you click on a forum.

Figure 5.12: Add a new topic to a forum.

Note: An administrator also always has the buttons Edit forum and Delete forum available to make changes to
the forum set up.

1. Subject: Type the concise description of what you wish to discuss in this forum thread.

2. Body: Elaborate on the topic.

3. Sticky: admin-only setting to keep the topic at the top of the forum threads.

4. Closed: admin-only setting to prevent others from responding to this post. Moderators and administrators
can still post replies.

5. Click the Post button to send off your discussion topic, or click Cancel to abort your action.

Note: When you write your forum topic, i.e. your first post, and any other subsequent post, you have formatting
options at your hands in the visual editor (when it is enabled). It also allows you to insert images into your post.
However, you should not copy the URL of one of your images from your Files area. This image is only displayed
to you unless it is also included in page that you made available to this group, logged-in users or the public.
Permissions on artefacts are governed by the permissions set on the page(s) in which they are included.

In some groups you may be able to upload files into the group thus allowing every group member to see the file.
You could link it then in your forum post but must be aware that any group member could delete the image.

Once you have finished writing your forum topic, it is displayed in the list of forum topics. Others can see it
immediately. The administrator and moderator of the forum can edit or delete a topic. Regular members cannot
do so.

1. The title of the forum

2. The title of the forum topic
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Figure 5.13: First post in a forum topic

3. The profile picture and name of the person who wrote the post. The name is linked to the profile page

4. The number of posts of this person in all groups

5. The date and time of the forum post

6. The post itself

7. The Reply button to comment on the post

Reply to a topic or subsequent post

Everybody can reply to a forum topic or other posts therein unless the moderator or administrator had closed the
topic. The replies are intended to make it easier to see to which comment you replies except in forum topics that
do not use indentation.

Figure 5.14: Reply to a forum post

1. Click the Reply button below the forum post to which you wish to reply. The forum post that you are
replying to is displayed beneath your reply window making it easier for you to refer to it if necessary.

2. Set a different subject if you want to by clicking on Click to set a subject. This is most often not necessary
and usually only used if the topic evolves into a different discussion. However, in such cases, a new forum
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topic should be opened.

3. Write your comment.

4. Click the Post button to save your response or the Cancel button to abort your forum post.

Note: Once you have saved your post, you may have time to edit it before it is sent to the forum subscribers. That
depends on the site settings for the forum post delay. If you can edit your post, you see the Edit button. In the edit
window, you also see how much time you have left until your post is sent.

When you, but also a moderator or an administrator, edit your forum post after this time, it is stated when and by
whom the editing was done under “Edits to this post”.

Delete a post, topic or forum

A moderator or administrator can always edit or delete a single forum post, a topic or an entire forum.

Warning: Once a forum post, topic or forum is deleted, this action cannot be reversed and the content is gone
forever.

Forum bulk actions

Group administrators and forum moderators can perform bulk actions on forums in a group.

1. Select the topics for which you want to perform the same action.

2. Choose the action that you wish to perform from the drop-down menu. You can set all selected topics to

• sticky: They will sit on top of all other forum topics.

• unsticky: They will be placed into the correct chronological order.

• close: Only the group administrator and forum moderator can add posts to these topics.

• open: Everyone can post to these topics again.

3. Click the Update all selected topics button to save your changes.

5.4.4 Pages

Members of a group have access to shared pages. These can be:

• pages that are created in the group

• pages that are shared with the group

The latter are pages that a user makes accessible to the group from his personal pages by sharing them with the
group. Members of the group cannot edit these pages.

Depending on the group type, either only administrators or also regular group members can create and edit group
pages.

62 Chapter 5. Groups



Mahara Documentation, Release 1.4

Figure 5.15: Forum bulk actions

Warning: Everybody who can edit a group page can add or delete blocks on that page. There is no version
tracking that shows who has edited what. Users should trust each other when collaborating on pages together.
Otherwise, it may be better if they only shared pages with a group.

Group homepage

The group homepage can only be edited by the group administrator. It contains a number of default blocks. You
can add more blocks to it to customize the page for the group. Please refer to the overview of blocks for a list of
all the blocks that you can use in the group homepage.

Regular group pages

Creating, editing and sharing a group page is very similar to creating, editing and sharing a portfolio page. Not
all blocks are available when editing a group page in the page editor though due to the different context. Please
refer to the overview of blocks for a list of all the blocks that you can use in a group page.

See Also:

For submitting a page to a group to receive instructor feedback, please refer to the feedback section.

5.4.5 Files

The files area in a group holds all files that are uploaded by group members who have the permission to do so.
The uploading process works as the one in the personal files.

In contrast to the files in your personal files area, there is an additional permissions setting:

When you have the permission to upload a file, you can also determine additional permissions of who can view
the file and edit its metadata. An administrator has all rights, but you can restrict them to regular group members
or tutors in a course group.

• View: You can see the file in the group files area and add it to a page.
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Figure 5.16: Setting permissions on a group file

• Edit: You can edit the file name, description, tags and permissions.

• Publish: You can include a group file in your personal portfolio pages.

5.5 My friends

Your friends are special group on Mahara. You can share your portfolio pages easily with them and get in touch
with them quickly by going to this page. They differ from a regular group in that they do not have discussion
forums, pages or share files. If you do wish to do that with your friends, you have to create a regular group for
them.

You can request other users’ friendship in a couple of ways:

• Go to their profile page and click the Request friendship link.

• Go to the Find friends page and search for potential friends there.

Figure 5.17: “My friends” page

1. If you have a lot of friends and pending friend requests, you can filter them by showing only the category of
friends (current or pending).

2. Click on the name of your friend to reach his profile page.
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3. If a friend is in the pending state, approve or deny the request.

4. Send a message to the friend if you wish to do so.

5. If you no longer want to have a user on your friend list, you can remove him by clicking on the Remove
from friends link.

6. If you are a group administrator in a group that one of your friends belongs to, you can edit his group
membership here as well.

5.6 Find friends

If you want to establish your social network on Mahara, you can use the Find friends page to find people to connect
to. An alphabetical list of all users on the system is provided.

Figure 5.18: “Find friends” page

1. Use the search box to search for a name.

2. All results are listed. You can click on the name to view that user’s profile page.

3. You find more information about this user and can take more actions:

• The name of the institution of which he is a member

• Send this user a message without requesting friendship

• Send this user a friend request

Note: You can prevent others from sending you messages or friend requests if you disabled these in your account
settings.

5.6.1 Send a friend request

You send a friend request from the Find friends page by clicking on the Send Friend Request! link next to the user
you want to be friends with.

1. Give a reason why want to request friendship of this user. This reason can be important if the other person
does not know you well, and thus may likely reject your request.

2. Click the Request friendship button to send off your friend request or click the Cancel button to abort your
action.

5.6.2 Accept a friend request

When another user has requested friendship, you receive a notification which is shown in the login box.

When you click on the friend request, you are taken to your My friends page. All your pending friend requests are
shown.

5.6. Find friends 65



Mahara Documentation, Release 1.4

Figure 5.19: Send friend request

Figure 5.20: Pending friend request

Figure 5.21: View all your pending friend requests
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1. View the name of the person requesting friendship and a short desciption if one had been written. You can
click on the name and see the profile page.

2. Read the reason why this user requests friendship.

3. Click the Approve Request! link to approve the friend request. Once you approved a friend request, you
appear immediately on that user’s My friends page and the user on yours.

4. Click the Deny Request link to deny friendship.

5. Click the Send message button to communicate with the user before making your decision about the friend
request.

5.6.3 Deny a friend request

When somebody sent you a friend request, go the My friends page to view your pending requests.

1. Next to the person whose request you wish to deny, click the Deny Request link.

2. Provide a reason for your denial if you wish to give one.

3. Click the Deny friend request button to send you message off or click the Cancel button to abort your action.

4. The user receives a notification that includes your reason for denial.

5.7 Shared pages

This page lists the most recently modified or commented on pages that have been shared with:

• you directly

• you as a friend

• you as a member of a group

Not displayed are pages that have only been shared with:

• the public

• all logged-in users

That means, if a page has been shared with all logged-in users and in addition with you, you see the page on your
shared pages. Otherwise, it does not appear here.

The shared pages are a quick way to find the pages that you may be most interested in looked at.

You cannot add or delete anything from this page. It is a display page only.

Figure 5.22: “Shared pages” list

1. You can filter the pages that have been shared with you by title, desctiption and tags or by tags only.

2. The title and author of the page are linked so that you can jump to them quickly.
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3. The description of the page as well as the tags are displayed.

4. You see the number of comments on each page.

5. The beginning of the latest comment on the page as well as its author and the date are displayed.

6. By clicking on the View comment button you can read the entire comment.

5.8 Topics

Topics is a list of the discussion topics from all the groups in which you are a member. The topics are sorted in
reverse chronological order starting with the latest comment.

Figure 5.23: The latest posts in discussion forums

1. The title of the forum topic as well as the group and the forum in which this topic is discussed are shown.
They are all linked so that you can easily go to them.

2. The number of posts in this discussion topic is displayed.

3. The beginning of the latest comment in the topic is displayed as well as the name of the author (linked to
the author’s profile page) and the date and time when the comment was made.

4. The total number of forum topics is displayed. When there are many forum topics, 10 are displayed per
page and the rest can be reached via a navigation bar.

Groups in Mahara can be used for collaboration among users as they offer the possibilities to

• discuss topics in forums

• create and edit pages together

• share files

• share pages

• submit pages for assessment

Note: Groups can be created by every user, staff or administrators only. The site administrator decides that in
Site Administration -> Configure Site -> Group Settings.

The Groups menu has a number of sub menus:

• My Groups: Displays the groups that you administer or in which you are a member. You can create new
groups from here if you have the appropriate rights.

• Find Groups: Lists all groups in the system and allows you to join or request membership in them if groups
allow that.

• My Friends: Displays your friends and gives you easy access to their profile pages.

• Find Friends: Search for users in Mahara that you may wish to add to your friends list.
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• Shared Pages: Lists the pages that were shared with you directly, with you as a friend or member of a group.

• Topics: Shows the latest discussion topics in your groups.
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CHAPTER

SIX

BLOCKS

Blocks for internal and external artefacts are used to compose portfolio pages and group pages. There is a large
number of blocks available in Mahara. More can be used when plugins are installed.

6.1 External content

With the help of the external content blocks, you can include RSS feeds, external media or GoogleApps documents
etc. into a page.

6.1.1 External feed

Embed an external RSS or ATOM feed, e.g. to display an external blog.

1. Block Title: If you leave the title blank, the title of the feed will be taken.

2. Feed location: Put the entire feed URL from a valid RSS or ATOM feed in here. If the feed is not displayed,
try to view it in a regular feed reader to make sure that the URL is correct.

3. Items to show: Decide how many of the latest items in the feed you wish to display. You can choose up to
20.

4. Show feed items in full?: If you do not select this option, only a heading will be shown for each feed item,
e.g. the blog heading of a post. If you select this option, the entire content of the feed item will be shown,
e.g. the entire blog post or in case of a flickr RSS feed, the photo and its description.

5. Click the Save button to accept your changes, or click the Remove button to remove this block from your
page.

Note: If your feed is not updated automatically, please ask your site administrator to check the cron settings.

6.1.2 External video
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Figure 6.1: Configure the external feed block

Embed an external video from:

• YouTube

• Google Videos

• TeacherTube

• Scivee.tv

1. Block Title: Choose a title for your video.

2. Video URL: Paste the video embed code or the URL of page where the video is located.

3. Width and Height: Choose the width and the height for the video.

4. Click the Save button to accept your changes, or click the Remove button to remove this block from your
page.

Note: If you use the embed code for a video, you still have to provide the correct width and height for the video
although they are already exist in the embed code. Mahara ignores these variables from the embed code.

6.1.3 Google Apps
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Figure 6.2: Configure the external video block

Embed any of the following content available via Google (Apps):

• books

• calendars

• documents, spreadsheets, presentations

• maps

You can only display the content, but not immediately edit documents, spreadsheets or presentations. You will
have to be logged in to your Google (Apps) account to do so. You can use this block with a regular, personal
Google account or if you have a Google Apps account via an institution, e.g. your school or university.

Note: If certain documents are restricted to a Google Apps domain or to specific people, a login screen is
displayed.

1. Block Title: Choose a title for your embedded content.

2. Embed code or URL: Depending on what kind of content you wish to display, you either provide the embed

code or the URL. Click on the button for more information on how to embed each Google component.

3. Height: Choose the height for the embedded content. The width is adjusted to the column width of the
block automatically.

4. Click the Save button to accept your changes, or click the Remove button to remove this block from your
page.

Google document

1. Open the Google Docs document.

2. Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click
File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper
right-hand corner.

3. Click the Start publishing button.

4. Copy the document link or embed code.
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Figure 6.3: Configure the Google Apps block
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5. Paste the link / embed code into the Embed code or URL box in the Google Apps block.

Google spreadsheet

1. Open the Google Docs spreadsheet.

2. Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click
File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper
right-hand corner.

3. Click the Start publishing button.

4. Copy the link.

5. Paste the link into the Embed code or URL box in the Google Apps block.

Google presentation

1. Open the Google Docs document.

2. Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click
File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper
right-hand corner.

3. Click the Start publishing button.

4. Copy the document link or embed code and adjust any of the other settings if you wish.

5. Paste the link / embed code into the Embed code or URL box in the Google Apps block.

Google collections

1. In Google Docs click My collections or Collections shared with me (list on left side)

2. Click and select the collection that you wish to embed -> click Sharing -> Settings OR if you use the new
interface: Click on the arrow to the right of the collection name and then on Share -> Share. Alternatively,
put a checkmark in front of the collection that you wish to share and go to the More menu item -> Share ->
Share.

3. Change the permissions to Public and save your changes.

4. Copy the link.

5. Paste the linke into the Embed code or URL box in the Google Apps block.

Google docs viewer

This functionality works like the preview functionality in Gmail. You can embed the file, which is directly ac-
cessible over the Internet. You just have to paste the complete URL (including the filename) on which the file is
accessible to the Google Apps block.

If you use the new interface, you must publish the document first: Click File -> Publish to the web. You do not
have to set any sharing options via the Share button in the upper right-hand corner.

Google Docs Viewer currently supports embedding of the following file types: PDF, TIFF, PPT, DOC, DOCX.

Note: The files you uploaded to Mahara are not directly accessible, so you can’t embed those files.

Google Calendar

1. Open Google Calendar.

2. Click on the little triangle next to the calendar that you wish to embed.

3. Click on the calendar settings.

4. On the Calendar details tab scroll down to Embed This Calendar.

5. Customize the calendar appearance and then copy the embed code.

6. Paste the embed code into the Embed code or URL box in the Google Apps block.
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Google Maps

1. Open Google Maps.

2. Click My Maps (My Places in the new interface) link on the upper left side.

3. Click on the name of the map that you wish to embed.

4. Click Link (the link icon in the new interface) link on the upper right side.

5. Customize the appearance of the map and copy the embed code.

6. Paste the embed code into the Embed code or URL box in the Google Apps block.

Note: Use steps 2 and 3 only if you wish to embed your Google map. If you wish to embed any Google map,
you can skip steps 2 and 3.

Google Books

1. Open Google Books.

2. Find the book that you wish to embed.

3. Click on the book title.

4. Click on Link on the upper right side.

5. Copy the embed code of the book.

6. Paste the embed code into the Embed code or URL box in the Google Apps block.

Note: The link icon only appears if you are allowed to embed this book.

6.2 Files, images and video

These artefacts are internal Mahara ones to display links to files that you have uploaded, folders that contain files,
show images, embed audio and video files.

6.2.1 File(s) to Download

Select files that viewers of your portfolio can download.

1. Block Title: Choose a title for your document block.

2. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

3. Upload file: You do not have to go back to your Files area in Content in order to upload a file. You can do
so directly from this screen.

4. Folder path: The breadcrumbs show in which folder you are currently.

5. You can still edit any component of the file, i.e. its file name, description and tags by clicking on the Edit
button.

6. Choose the file or files you wish to display by clicking on the Select button.
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Figure 6.4: Configure the file(s) to download block
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7. Click the Remove button to not display a specific file in this block anymore.

8. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: You cannot re-order files once you have them selected. You would need to remove them and select them
again in the correct order.

When the block is placed on the portfolio page, the following information is displayed:

• file name

• file description

• size

• upload date

• a link to more details

Figure 6.5: Details about files that can be downloaded.

When a user clicks on the Details link, he is taken to the details page for that particular file and sees some more
metadata. He could also report the file, print the page or add the page to his watchlist.

Figure 6.6: More details about a file that can be downloaded.
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Note: If you allowed comments on files, a setting that you can add when you edit a file, users could also leave
comments on an artefact file directly and not just on a page.

6.2.2 A Folder

Select files that viewers of your portfolio can download.

Figure 6.7: Configure the folder block

1. Block Title: If you leave the title blank, the title of the folder that you choose to display will be taken.

2. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

3. Folder path: The breadcrumbs show in which folder you are currently.

4. You can edit any component of the folder, i.e. its name, description and tags by clicking on the Edit button.

5. Choose the folder you wish to display by clicking on the Select button. If you want to revert your selection,
click the Remove button.

6. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.2.3 Image Gallery

Select a folder with images or individual images to show in a gallery.
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Figure 6.8: Configure the image gallery block
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1. Block Title: Choose a title for your image gallery block.

2. Image Selection: You can choose to display all images from a specific folder or you can select the images
individually.

3. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

4. Folder path: The breadcrumbs show in which folder you are currently.

5. You can edit any component of the folder, i.e. its name, description and tags by clicking on the Edit button.

6. Choose the folder you wish to display by clicking on the Select button.

7. If you want to revert your selection, click the Remove button.

8. Style: Decide to show all selected images as thumbnails or as slideshow where you only see one image at a
time.

9. Width: Specify the width (in pixels) for your images. The images are scaled to this width.

10. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: If you selected to display an entire folder in your image gallery, new images that you upload to that folder
are added to your gallery automatically.

6.2.4 Some HTML

Display the content of an HTML file in a page.

1. Block Title: Choose a title for your block.

2. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

3. Upload file: You do not have to go back to your Files area in Content in order to upload a file. You can do
so directly from this screen.

4. Folder path: The breadcrumbs show in which folder you are currently.

5. You can still edit any component of the file, i.e. its file name, description and tags by clicking on the Edit
button.

6. Choose the file you wish to display by clicking on the Select button.

7. Click the Remove button to not display that file in this block anymore.

8. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: You can only display a self-contained HTML file in a Mahara page, but not an entire site because the links
to the files are not retained correctly when you upload files to Mahara.
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Figure 6.9: Configure the html block
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6.2.5 An Image

Display a single image in a block.

Figure 6.10: Configure the image block

1. Block Title: Choose a title for your block.

2. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

3. Upload file: You do not have to go back to your Files area in Content in order to upload a file. You can do
so directly from this screen.

4. Folder path: The breadcrumbs show in which folder you are currently.

5. You can still edit any component of the file, i.e. its file name, description and tags by clicking on the Edit
button.

6. Choose the file you wish to display by clicking on the Select button.

7. Click the Remove button to not display that file in this block anymore.
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8. If your file has a description you can choose to display it. The description could contain the source of the
photo for example.

9. Choose the width (in pixels) for your photo. If you do not provide a number, the image will be scaled to the
width of the block.

10. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.2.6 Embedded Media

Display an embedded video or audio file from your uploaded files. You can display mp3, mp4 and flv files.

Figure 6.11: Configure the media block

1. Block Title: Choose a title for your block.

2. Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of
a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts
are shown as well, e.g. the Site Files.

3. Upload file: You do not have to go back to your Files area in Content in order to upload a file. You can do
so directly from this screen.
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4. Folder path: The breadcrumbs show in which folder you are currently.

5. You can still edit any component of the file, i.e. its file name, description and tags by clicking on the Edit
button.

6. Choose the file you wish to display by clicking on the Select button.

7. Click the Remove button to not display that file in this block anymore.

8. If your file has a description you can choose to display it.

9. Choose the width and height (in pixels) for your video.

10. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: Only the files that you are allowed to embed are displayed. If you uploaded a mp4 file but it does not show
here, you may have to check if it has the correct codec. Only H.264 mp4 files can be embedded.

6.3 General

The artefacts in this tab are of a general nature or did not fit into any other category and can be used around the
site.

When you create a page in a group, you do not have the navigation and plans blocks available as you cannot
create collections or plans in groups. Additionally, you can choose the following blocks when you edit the group
homepage:

• Group Info

• Group Members

• Group Pages

6.3.1 Creative Commons License

Add a block to your page which lets users know under which Creative Commons license your page is published.

1. Block Title: Choose a title for your document block.

2. Allow commercial uses of your work? Decide whether users can re-use your work for commercial pur-
poses.

3. Allow modifications of your work? Decide whether others can remix your work and create something new
and if so under which conditions.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

See Also:

For more information about the licenses and their terms, visit the Creative Commons web site.
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Figure 6.12: Configure the Creative Commons block

6.3.2 Navigation

Add a navigation block to display links to pages in a collection.

Note: You must create at least one collection first in order to use this block.

Figure 6.13: Configure the navigation block

1. Block Title: The title of the collection is chosen automatically unless you provide a different one.

2. Collection: Choose the collection from the drop-down menu for which you wish to display links in the
block.

3. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.
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6.3.3 Your Plans

Display one of your plans in a block.

Note: You must create at least one plan first in order to use this block.

Figure 6.14: Configure the plans block

1. Block Title: The title of the plan is chosen automatically unless you provide a different one.

2. Plan to show: Choose the plan which you want to display in your page.

3. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.3.4 Recent Forum Posts

Display a specified number of recent forum posts from one group on a page.

Note: You must be a member of at least one group in order to use this block.

1. Block Title: The title of the block is generated automatically unless you provide a different one. The default
title is “Recent Forum Posts”.

2. Group: Choose the group whose forum posts shall be displayed.

3. Maximum number of posts to show: Decide how many of the latest forum posts you wish to show. The
default value is 5.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.
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Figure 6.15: Result of an embedded plan in a portfolio page. By clicking on the linked titles, you can show the
descriptions of the individual tasks.

Figure 6.16: Configure the recent forum posts block
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6.3.5 Text Box

Add text to your page. This feature is used when you do not want to keep the text in a journal, e.g. just for small
snippets of text.

Warning: If you remove a text box from a page, its content is deleted forever and cannot be retrieved anymore.
Only in the upcoming Mahara 1.5 version will text boxes be artefacts that can be stored and re-used.

Figure 6.17: Configure the text box block

1. Block Title: Provide a title for your text.
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2. Block Content: Write your text. You can include formatting, external images etc.

3. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: We recommend you do not include images that you have uploaded to Mahara in a text box. It cannot be
guaranteed that they are displayed for other users if they do not have access to the image via another portfolio
page. All access in Mahara is granted to pages and through them to the artefact blocks. An image in a text box is
not recognized as artefact and can therefore not receive its proper permissions.

6.3.6 My Inbox

The My Inbox block displays the latest messages that you have received in Mahara.

Note: This block can only be used on your dashboard.

1. Block Title: The automatic title for this block is “Recent Activity”. You can set another one if you wish.

2. Message types to display: Place a check mark for each message type that you want to display in this block.

3. Maximum number of items to display: Decide how many pages shall be shown on your dashboard. You
can choose between 5 and 100.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.3.7 Latest Pages

The Latest Pages block displays the latest pages to which you have access across Mahara.

Note: This block can only be used on your dashboard.

1. Block Title: The automatic title for this block is “Latest pages”. You can set another one if you wish.

2. Maximum number of pages to show: Decide how many pages shall be shown on your dashboard. You
can choose between 5 and 100.

3. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.
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Figure 6.18: Configure the inbox block
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Figure 6.19: Configure the latest pages block

6.3.8 Group Info

This block is a default block on the group homepage. There is no configuration possible. The block contains
information about:

• group administrator

• group type

• group creation date

• number of group members

• number of pages created in the group

• number of files uploaded to the group

• number of folders created in the group

6.3.9 Group Members

This block is a default block on the group homepage. You can display member profile pictures and their names.

1. Block Title: The automatic title for this block is “Members”. You can set another one if you wish.

2. Shown Members: Choose how many members (between 1 and 20) are shown on the group homepage. All
others are accessible via the Members tab in the group.

3. Order: Choose the order in which members are displayed. Options are:
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Figure 6.20: Configure the group members block

• latest: display members according to their group joining date in reverse chronological order

• random: let Mahara decide which members to display

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it is.

6.3.10 Group Pages

This block is a default block on the group homepage. You can display pages created in and / or shared with the
group in this block.

Figure 6.21: Configure the group pages block

1. Block Title: The automatic title for this block is “Group pages”. You can set another one if you wish.

2. Display Group pages? Decide whether to display pages that were created in the group. “Yes” is the default
option.
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3. Display Shared pages? Decide whether to display pages that users shared with the group. “No” is the
default option.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it is.

6.4 Journals

You can embed content from your journals in various ways in a page:

• display an entire journal

• display only one journal entry

• show the latest journal entries

Note: You must create at least one journal in order to see anything in this block.

Warning: You can allow the copying of your journal (entries). Choose this option wisely because once a user
copied your journal content into their portfolio, it looks as if they had written the journal entries. This could
lead to plagiarism. However, it can be used very nicely to create templates and to scaffold learning.

6.4.1 Display an entire journal

Display an entire journal in your portfolio page.

Figure 6.22: Configure the journal block
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1. Block Title: The title of the journal is chosen automatically unless you provide a different one.

2. Journal: Select the journal you wish to display. If you have many journals, you can also search for the one
you want to use.

3. Entries per page: Decide how many entries you want to display. Entries beyond this number are accessible
via a page navigation bar.

4. Block copy permissions: You decide what shall happen with this block when you allow other users to copy
your page. Options are:

• Skip this block entirely when copying the page

• Others may display your journal in their page

• Others will get their own copy of your journal

5. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: If you share the page in which you make an entire journal visible with the public, your journal receives an
RSS feed to which your readers can subscribe in their favorite RSS readers.

6.4.2 Display one journal entry

Display an entire journal in your portfolio page.

Figure 6.23: Configure the journal entry block

1. Block Title: The title of the journal post is chosen automatically unless you provide a different one.
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2. Journal Entry: Select the journal entry you wish to display. If you have many posts, you can also search
for the one you want to use.

3. Block copy permissions: You decide what shall happen with this block when you allow other users to copy
your page. Options are:

• Skip this block entirely when copying the page

• Others may display your journal entry in their page

• Others will get their own copy of your journal entry

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.4.3 Display recent journal entries

Display an entire journal in your portfolio page.

Figure 6.24: Configure the recent journal entries block

1. Block Title: Choose a title for your block.

2. Journal: Select the journal(s) from which you wish to display the latest posts. If you have many journals,
you can also search for the one you want to use.

3. Items to show: Decide how many posts you want to display.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: If you have multiple journals, you can display recent posts from all of them.
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6.5 Profile

The artefact blocks in this tab allow you to include information that you provided in the Profile into your portfolio.
If you want to make changes to the text or the images, you will have to go to Content -> Profile.

Furthermore, you can also put certain blocks onto your Mahara profile page that only exist for that particular page:

• My Friends

• My Groups

• My Pages

• Wall

6.5.1 Contact information

Add a block with contact information to your page.

Note: Only display as much information as you wish anybody to see. Especially when you make your pages
available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to
display your street address and / or phone number.

Figure 6.25: Configure the contact information block

1. Block Title: Choose a title for your block.

2. Email Address Decide whether to display one of your email addresses that Mahara knows.

3. Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that
you want to show. Displayed are only the ones for which you provided content.
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4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.5.2 My Friends

Add a block that displays your friends’ profile pictures and their names to your profile page. This is a default
block on your profile page.

You only need to place the block into your profile page. There is no further configuration possible.

6.5.3 My Groups

Add a block that displays your groups to your profile page. It is a standard profile page block.

You only need to place the block into your profile page. There is no further configuration possible.

6.5.4 My Pages

Add a block that displays your pages to your profile page. It is a standard profile page block. This block should
stay on your profile page because it is an easy way for other users to access your pages.

You only need to place the block into your profile page. There is no further configuration possible.

Note: When a user views your profile page, he only sees the pages to which he has access. That also means that
you see all your pages while others may see none or just a few.

6.5.5 Profile information

Add a block with profile fields to your page.
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Note: Only display as much information as you wish anybody to see. Especially when you make your pages
available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to
display your street address and / or phone number.

1. Block Title: Choose a title for your block.

2. Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that
you want to show. Displayed are only the ones for which you provided content.

3. Profile Picture: Choose to display one of your profile pictures or none.

4. Email Address Decide whether to display one of your email addresses that Mahara knows.

5. Introduction Text: If you do not want to display the introduction text from your profile, you can write
another one just for this page here. However, it will be lost when you delete this block.

6. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

6.5.6 Wall

Add a block that displays your wall to your profile page. It is a standard profile page block.

You only need to place the block into your profile page. There is no further configuration possible.

6.6 Résumé

You can display either your entire résumé or parts of it in any portfolio page. If you choose to display only parts
of your résumé, you have more control over the arrangement of the information.

6.6.1 Display your entire résumé

Add a block with your entire résumé to your page.

1. Block Title: Choose a title for your block.

2. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.
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Figure 6.26: Configure the profile information block
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Figure 6.27: Configure the full résumé block

6.6.2 Display one résumé field

Add a block with one résumé field to your page.

Figure 6.28: Configure the One Résumé Field block

1. Block Title: The title of the résumé field you want to display is chosen automatically unless you provide a
different one.

2. Field to show: Choose the résumé information that you want to display. You can select one area at a time.

3. You can jump to the résumé section directly from this pop-up window in order to fill in more content.

4. Click the Save button to accept your changes, or click the Cancel button to leave the block’s content as it
is. The Remove button is shown only when you place the block into the page and have not yet added any
artefacts.

Note: Normally, only résumé fields are shown for which you have provided content. However, as soon as you fill
in a skills or goals area, all headings are displayed even when they do not contain any content.
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6.7 Blocks in various pages

Certain blocks can only exist in certain page contexts. For example, the wall can only be placed on the profile
page whereas the text box can be used on any page. There are a number of page contexts which can have different
blocks:

• portfolio page

• group page

• institution page

• site page

• profile page

• dashboard page

The following list shows in which contexts a specific block and therefore a specific artefact can be used.

See Also:

This list has been adapted from a training resource published by Synergy Learning for Mahara 1.3.

External content
Block User Group Institution Site Dashboard Profile Group

homepage

External feed

External
video

Google Apps

Files, images and video
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Block User Group Institution Site Dashboard Profile Group
homepage

File(s) to
Download

A Folder

Some HTML

An Image

Image
Gallery

Embedded
Media
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General
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Block User Group Institution Site Dashboard Profile Group
homepage

Creative
Commons
License

Navigation

Text Box

Your Plans

Recent
Forum Posts

Group Info

Group
Members

Group Pages

My Inbox

Latest Pages
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Journals

Block User Group Institution Site Dashboard Profile Group
homepage

Display an
entire
journal

Display one
journal entry

Display
recent
journal
entries

Profile
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Block User Group Institution Site Dashboard Profile Group
homepage

Contact
information

Profile
information

My Friends

My Groups

My Pages

Wall
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Résumé
Block User Group Institution Site Dashboard Profile Group

homepage

Display your
entire
résumé

Display one
résumé field
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CHAPTER

SEVEN

SETTINGS

7.1 Account settings

The account settings of a user can be accessed via the Settings page. It is located in the top right-hand corner next
to Inbox and Logout in a standard Mahara instance.

7.1.1 New password

You can change your Mahara password on the Settings page:

1. Enter your current password.

2. Enter your preferred new password in the New Password and Confirm password box.

3. Make further changes on the page if you wish.

4. Click the Save button at the bottom of the page.

Your password must have a minimum of six characters. It must contain at least one number, and at least two
letters. Passwords are case sensitive and must be different from your username.

Figure 7.1: Change your password

Note: If you do not see the New password box, you cannot change your password in Mahara. Your login and
password are managed elsewhere. This is the case if your institution has set up single sign-on to other applications
for example. If you want to change your password, please contact your institution administrator. He will be able
to tell you where you can change your password.

7.1.2 Change username

You need a username to log in to Mahara. If your account is not managed by single-sign on or another method,
you see this box. You can then change your username at any time.
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Note: Usernames are 3-30 characters long and may contain letters, numbers and most common symbols excluding
spaces.

Figure 7.2: Change your username

7.1.3 General account options

The general account options are visible to all users no matter whether they can change their usernames and pass-
words or not.

Figure 7.3: View and change your general account options

1. Friends control: Choose whether other users may add you to their friends list. If you are added to a friends
list, the owner of that list is added to your list. When you remove someone from your friends list you are
also removed from their list.

2. HTML editor: An HTML editor is available for use on some sections of the site. This is known as a ‘What
you see is what you get’ (WYSIWYG) editor. This allows you to apply formatting to your text like in a
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word processor. If the editor is turned off you can only enter plain text. If you do not have this option, the
site admin may have disabled it.

3. Email: Use this setting to stop Mahara from sending you emails. It is advised that you generally regulate
what is sent via email and what is not in the notifications.

4. Message from other users: Use this setting to choose who you wish to receive messages from. Use the
notifications area to decide how you will receive these messages. Note: These restrictions will not apply to
users with the ‘administrator’ or ‘staff’.

5. Language: If your Mahara instance is offered in multiple languages, you can choose in which one you
want to navigate the site. The menu items and the contextual help appear in the language you have chosen.
However, the content does not.

6. Show controls to add and remove columns when editing a page: You can add the Add and Remove
buttons in the page editor to quickly change the number of columns in a portfolio page, see edit layout.

7. Enable multiple journals: By default, you have one journal. If you would like to keep more than one
journal, choose this option.

8. Maximum tags in cloud: Decide how many tags you wish to display in your personal tag cloud.

9. Show information about Mahara on the homepage: You choose this option if you want to display the
quick links on your dashboard.

10. Mobile upload token: Enter a token, e.g. a word, her and on your Android phone or iPhone to enable
uploads. Your token changes automatically after each upload. See Mobile Mahara for more information on
using Mahara with a mobile device.

11. Click the Save button whe you have finished making your changes.

Warning: If you disable your email address, you cannot reset your password as that requires a sending of an
email to your address.

7.1.4 Delete account

If your Mahara site allows self-registration, you can delete your own account by clicking on the Delete account
link on the top of the settings page.

Warning: Be absolutely sure that you want to delete your account. Your artefacts and portfolio pages cannot
be restored once you deleted your account. Everything will be gone. You can make a backup of all your things
(excluding group content) by exporting your portfolio.

7.2 Notifications

Mahara sends notifications for a number of different activities:

• System message: automatically generated by the system or sent to you by one of the site administrators,
e.g. account confirmation message.

• Message from other users: sent to you directly from other users of the site.

• Watchlist: notification of activity on any artefact, page or journal you are monitoring.

• New page access: notification that you or one of your groups have been given access to a new or existing
non-public page. You do not receive notifications about pages accessible to all logged-in users and the
public.

• Institution message: automatically generated by the system, e.g. institution confirmation message, institu-
tion removal message, institution request sent to administrator

• Group message: automatically generated by the system, e.g. user request for joining a group
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• Feedback: notification of any feedback or comments received on any pages, artefacts or journal posts.

• New forum post: notification about new posts in forums to which you are subscribed.

• Contact us: messages to administrators that are sent via the Contactu us form.

• Objectionable content: messages to administrators that contain complaints by users about objectionable
content.

• Repeat virus upload: messages to adminsitrators about users who repeatedly upload virus-infected files.
Virus checking must be turned on.

• Virus flag release: messages to administrators about files that were released by the virus scanner.

You may select how you receive notifications for each activity type. To do so, go to Settings -> Notifications.

Figure 7.4: Notifications

1. Select the notification type for each type of activity. There are four notification types:

• Email: your primary email address will receive an email each time the activity occurs.

• Email digest: your primary email address will receive an email each day with a list of the activities of
the last 24 hours. Typically, this email is sent at around 6 p.m., but this can be changed.
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• Inbox: your notifications area will display a list of activity notifications received.

• None: This is only available to administrators for notifications that are only intended for administra-
tors. They can opt to not receive any notifications for certain types.

Todo

Where can you change the setting for when the email digest is sent?

Note: If you select either email or email digest, all activities will also be recorded in your inbox as they happen.
They will all be marked as already read. These notifications automatically expire and are removed from your
inbox after 60 days.

7.3 Inbox

You can view your notifications for your account in your Inbox which you access from the top-right corner next
to Settings and Logout.

Figure 7.5: Your inbox

1. Activity type: You can filter your notifications according to an activity type to see only a subset of all your
notifications.

2. Subject: The subject of the notification is linked so that you can click on it and get to the text of the
notification.

3. Date: View when the notification was sent.

4. Read: You can select individual or all notifications on that page that you want to mark as read.

5. Click the Mark as read button to mark the previously selected notifications as read. Notifications that are
sent to your email are marked as read automatically.

6. Delete: Select one or more notifications on that page that you want to delete.

7. Click the Delete button to permanently delete the notifications that you had selected for deletion.

8. Navigate through all your notifications with the help of the page navigation bar.
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9. You can delete all notifications at once. That will delete every notification no matter whether you see them
on the screen or not. They cannot be retrieved again. Only when you had sent messages to your email will
you still be able to view them if you have not deleted them there as well.

7.4 Institution membership

You can see in which institution(s) you are a member when you go to Settings -> Institution membership. You
may be able to leave your current institution and join other institutions if they allow self-registration. If you cannot
leave your institution, you must ask your institution administrator to remove you.

Note: Leaving an institution does not mean that your account will be deleted. You keep your content and portfolio
pages.

Figure 7.6: Check on your institution membership

1. Click on Settings -> Institution Membership to view your institution membership.

2. Memberships: Here you see to which institution(s) you belong. Click on the Leave institution button to
remove yourself from the institution. If you do not see this button next to an institution, you cannot remove
yourself but must ask an institution administrator to do so.

3. Requests: If you have already requested membership in an institution, it will be listed here. You must wait
for an institution administrator to approve your request. If you wish to cancel a request, click the Cancel
request button.
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4. Request membership of an institution: Choose the institution from the drop-down menu that you wish to
join.

5. You can provide an ID if you have one for this institution, but that is optional.

6. Click the Send request button, and the institution administrator is notified of your request and will dea with
it.
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CHAPTER

EIGHT

SITE ADMINISTRATION

The site administration in Mahara is reserved for site administrators who have full privileges. Institution adminis-
trators have fewer administrative rights and will be discussed separately.

8.1 Overview

8.1.1 Navigation

As site administrator you have an additional navigation item, Site Administration. When you click on it, your
navigation changes completely to give you quick acess to all the areas for the administration of Mahara.

Figure 8.1: Top level navigation for a site admin once inside “Site Administration”

When you click on one of the items, a second-level navigation opens up with the sub items. You also see the sub
items on the main page of the site administration.

8.1.2 Register your Mahara site

You can choose to register your Mahara site with mahara.org, and help us to build up a picture of the Mahara
installations around the world and to get a picture by how many users Mahara is used.

You can preview the data that is sent. Sending weekly updates is recommended so that the information we have
is up-to-date. All information is sent anonymously. We will only know, for example, which version of Mahara
you are running, how many times blocks or artefacts have been used, how many users you have etc.

8.1.3 Site information

The Site information gives you a quick overview of:

• How your site is used.

• When your site was installed.

• How big the database is.
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Figure 8.2: Site admin overview page

Figure 8.3: Register your Mahara site
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• How much sitea data has been accumulated.

• Which version of Mahara you are running.

• Whether your cron is running or not.

Figure 8.4: Site information

If you have problems with your Mahara instance and you request information from the community in the forums,
this information, esp. about your version and the cron, are useful to have. Furthermore, the version number allows
you to check that you have the latest security release of your Mahara version installed.

Note: The cron job is very important in Mahara as a number of vital tasks are only performed when it is running.
You can find more information of how to set it up in the wiki.

8.1.4 Site statistics

You can view some statistics about your Mahara site that give you an indication of how your site is used.

Full site information

The full site information gives you information about:

• Installation date of your site

• Number of registerered users (“Users”), i.e. everybody who has an account

• Number of active users, i.e. users that have at least logged in once and have done something

• Number of groups and average group membership of a user

• Number of pages and average pages per user with pages

• Database size

• Disk usage

• Mahara version

• Information on the cron
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Figure 8.5: Overview of the site

Users

On the Users tab of the site statistics, you see information about

• the average user

– average number of friends with the name of the person with most friends

– average number of pages with the author of the most pages

– average amount of file quota used with the user who has used most

• daily user statistics with information about how many users logged in, were created and existed in total on
a specific day

• institution membership with the number of users per institution in descending order

Groups

On the Groups tab of the site statistics, you find information about

• the number of groups by group type

– course group

– standard group

• the number of groups by access type

– controlled membership group

– invite group

– open membership group

– request membership group

• The size of the groups in descending order according to the number of members including

– number of members

– number of pages
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Figure 8.6: Statistics about users

– number of forums

– number of forum posts

Pages

The Pages tab in the site statistics holds information about

• the most frequently used blocks in portfolio pages

• a graphical distribution of profile, group and portfolio pages

• the most popular pages sorted in descending order with links to the page and the author

8.1.5 Close site

You may close the site to everyone except administrators. This is useful when you prepare for and complete a
database upgrade. Only administrators will be able to log in until you either reopen the site or an upgrade is
successfully completed.

8.2 Configure site

In Configure site you can:

• set general parameters for your Mahara site

• edit site pages
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Figure 8.7: Statistics about groups

Figure 8.8: Statistics about pages

122 Chapter 8. Site administration



Mahara Documentation, Release 1.4

• determine the display of certain menu items

• allow networking with Moodle

• create and share pages

• upload files

8.2.1 Site options

In Site options you can set some global options that will apply by default throughout the entire site.

Note: One or more fields in may be disabled if overridden by a setting in your config.php file.

When you are done editing one or more settings, click the Update site options button at the bottom of the page.

Site settings

Figure 8.9: Site settings

1. Site name: Choose a name for your Mahara instance. It appears in certain places around the site, e.g. in the
title bar of the browser, and in emails sent from the site. Therefore, it should not be too long.

2. Language: Set the default language for your site. If you have multiple language packs installed, you see a
drop-down menu. Otherwise, the standard language, English, is displayed.

3. Country: The country selected is the default for country selections throughout your Mahara installation,
e.g. in contact information.

4. Theme: Mahara comes with a number of themes that you can use. Choose one from the drop-down menu
to make it the default theme for your site. If you have institutions set up, they can choose their own theme.

5. Show homepage information: If enabled, information about Mahara and how it is used is displayed on the
Mahara homepage for logged-out and the dashboard for logged-in users. Logged-in users can disable this.
See also Quick links.

6. Send weekly updates?: If checked, your site send weekly updates to mahara.org with some statistics about
your site. See also Register your Mahara site.

Note: You can install more language packs. There is a complete list of them as well as more information about
the language packs on the wiki.
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Figure 8.10: User settings

User settings

1. Users can choose page themes: If this setting is enabled, users can select a theme for their portfolio page.
The page is displayed with this theme to other users. Thus, an institution or site theme can be overwritten.

2. Display remote avatars: If checked, users’ default profile pictures will be their Gravatar pictures (remote
avatar). Users will need an account with Gravatar for this to work.

3. Users can hide real names: If checked, users who have set a display name may choose to be searchable
only by their display name, and will not be found in searches for their real name. In the site administration
section of the site, users are always searchable by their real names. An administrator (site and institution)
always sees the display name, first and last name and username.

4. Search usernames: If checked, usernames can be searched on as part of “Search Users” on the dashboard
and via Find friends.

5. Anonymous comments: If checked, logged-out users / users without a login can leave comments on public
pages or pages they can access via secret URL.

Search settings

Mahara comes with a search plugin that allows you to search for users and pages. If you install another search
plugin, you will be able to select which one to use for your site.

Figure 8.11: Search settings

Note: The internal search plugin can be configured in the Plugin administration.

Group settings

Mahara cannot only be used for individual work but also to work collaboratively in groups. Some settings are
available in that area.
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Figure 8.12: Group settings

1. Who can create groups: You decide whether administrators, administrators and staff or everyone can create
groups. The default setting is the most permissive “everyone” because Mahara is user-centered and gives
the individual users a great deal of control over what they want to do. If you choose to limit the group
creation to administrators (and staff), these need to be contacted to set up groups. There is no internal group
request system.

2. Who can create public groups: Choose whether everyone or only administrators can create public groups.
These are groups for which you do not need to be a member of the group or even have a login to Mahara to
view the group homepage, member listing and discussion forums.

3. Allow group categories: If checked, administrators can create categories for users to assign to their groups.
These categories can be used to filter groups in My groups and Find groups.

Institution settings

You can use Mahara with multiple institutions and separate them for administrative purposes, e.g. user manage-
ment and permissions, and to give them a different theme.

Figure 8.13: Institution settings

1. Users allowed multiple institutions: If checked, users can be members of several institutions at the same
time.

• Advantage: A user who belongs to two or more institutions only needs one account.

• Disadvantage: If one or more institutions use custom themes, the user cannot choose which one is
displayed for him.

2. Warning time for institution expiry: If set, a notification will be sent to site and institution admins this
amount of time before an institution is due to expire and be suspended. This time may be specified in days,
weeks, months, years or “No end date”. If the latter option is chosen, institutions will not expire by default.

3. Auto-suspend expired institutions: If set, this option will allow Mahara to automatically suspend an insti-
tution that has expired automatically. This means that users of that institution will not be able to log in until
the institution has been unsuspended.
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Account settings

Figure 8.14: Account settings

1. Session lifetime: For security reasons, after a specified period of inactivity, a user will be logged off the site
automatically. This field specifies this time in minutes. The default value is 1440 minutes (24 hours).

2. Default account lifetime: If set, user accounts will expire after this amount of time from when they were
created. When a user account is expired, the user cannot log in. This time may be specified in days, weeks,
months, years or “No end date”. If the latter option is chosen, accounts will not expire by default.

3. Default account inactivity time: If set, users who do not log in for this amount of time will be considered
“inactive” and will not be able to log in anymore. This time may be specified in days, weeks, months, years
or “No end date”. If the latter option is chosen, users are not set to “inactive” by default.

4. Warning time for inactivity / expiry: If set, a warning message will be sent to users this amount of time
before their accounts are due to expire or become inactive. This time may be specified in days, weeks,
months, years or “No end date”. If the latter is chosen, users do not receive a warning before their account
expires or they are flagged as having an inactive account.

Security settings

Figure 8.15: Security settings

1. Virus checking: If you want all files uploaded by users to be run through a ClamAV virus scan, you should
select the virus checking option. You have to have ClamAV installed on your server.

2. Path to clam: The filesystem path to clamscan or clamdscan for virus checking. It is assumed that a failure
of ClamAV to run will mean that a file should be treated as a virus, and a quarantine directory will be
automatically set up by your Mahara installation.
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3. Anti-spam: There are three levels of anti-spam protection available for publicly visible forms, such as the
contact and registration forms. A form submission is never silently rejected. Rather, an error message is
displayed asking the user to try again if the submission is classified as spam. The three choices are:

• None: No anti-spam checks are performed on form submissions.

• Simple: Some basic checks are performed. Form submissions with email addresses that are not well-
formed or that have an excessive number of URLs are rejected.

• Advanced: Performs additional checks to determine whether email addresses are real or contain URLs
that are blacklisted. This requires an internet connection.

4. Enable Spamhaus URL blacklist: If enabled, URLs will be checked against the Spamhaus DNSBL. The
Spamhaus Project provides a URL blacklist that is free for non-commercial, low-traffic use. A professional
use datafeed service is also available but not supported in Mahara. Please read the Spamhaus DNSBL usage
terms before enabling this option.

5. Enable SURBL URL blacklist: If enabled, URLs will be checked against the SURBL DNSBL. SURBL
provides a URL blacklist that is free for organizations with fewer than 1000 users. A professional use
datafeed service is also available, but not supported in Mahara. Please read the SURBL usage terms before
enabling this option.

6. Disable external resources in user HTML: Turning this option on will prevent users from embedding
external resources such as images from remote sites into their forum posts and other HTML content. It is
however a good thing to do from a security standpoint since it does neutralise a few clever phishing attacks.
See the HTML Purifier documentation for more details.

Proxy settings

Figure 8.16: Proxy settings

1. Proxy address: If your site uses a proxy server to access the internet, specify the proxies in
hostname:portnumber notation.

2. Proxy authentication model: Select your proxy’s authentication model (none or basic [NCSA]), if appro-
priate.

3. Proxy credentials: Enter the credentials required for your proxy to authenticate your web server in
username:password format.

Email settings

1. SMTP host: If you want to force Mahara to use a specific SMTP server instead of the system one, enter
its hostname here, e.g. smtp.example.com. It is possible to specify more than one host by separating
them with semicolons, e.g. smtp1.example.com;smtp2.example.com, but keep in mind that all
other settings, e.g. authentication credentials and port numbers, will apply to all listed servers. It is not
possible to specify different credentials for each server in this list. This feature is useful when SMTP host
authentication is not required or you list different frontends for the same mail server in which case other
settings will work.
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Figure 8.17: Email settings

2. SMTP port: If your SMTP server uses a port number different from 25, you may specify it here. When
encryption is enabled, the default ports are 465 for SSL and 587 for TLS. You only need to specify a port
number if it is different from these. Check the correct settings with your mail service provider.

3. User: If your SMTP server requires authentication, enter your username here.

4. Password: If your SMTP server requires authentication, enter your password here.

5. SMTP encryption: If your SMTP server supports encryption, enable it here.

6. System mail address: This email address is the address that emails are sent from when using Mahara.

General settings

Figure 8.18: General settings

1. Allow public pages: If checked, users can create portfolio pages that are accessible to the public rather than
only to logged-in users.

2. Allow public profiles: If checked, users can set their profile pages to be accessible to the public rather than
only to logged-in users. However, only logged-in users can use interactive features such as the wall.
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3. Enable portfolio search: If checked, the “Search My Portfolio” side block is displayed in the Content and
Portfolio sections of the site.

4. Enable tag cloud: If checked, users see a side block in the Content and Portfolio sections of the site with a
list of their most frequently used tags.

5. Maximum tags in cloud: Enter the default number of tags to display in user tag clouds. Users can change
this number in their account settings.

6. Small page headers: If checked, a small header and site navigation block are displayed when viewing or
editing portfolio page instead of the standard header. This option gives more space for the portfolio content
itself.

7. Show online users: If checked, users see a side block with a list of the users who have been logged-in in
the last 10 minutes (cf. the dashboard).

8. Registration agreement: If checked, you force users to agree to the “Terms and Conditions” before regis-
tration. You should edit your site’s “Terms and Conditions” page before enabling this option. You can do
so under Edit site pages.

9. Allow mobile uploads: If checked, users have the option of setting an authentication token in their account
settings. That allows them to upload content from their mobile devices.

8.2.2 Edit site pages

Here you can edit the content of some pages around the site and the pages linked to in the footer:

• About

• Home (Dashboard)

• Logged-out home

• Privacy statement

• Terms and conditions

Note: Due to a quirk in the system, you do not see the text on the first page that is displayed in the editor -
generally “Home (Dashboard)”. In order to edit it, you need to click on a different page in the dro-down menu
first and then select it again to see its text.

All pages come with default text that you can change entirely. Every page must contain some text. You can use
the visual editor to style your page.

1. Choose the page you want to edit from the drop-down menu.

2. Change the text in the editor window. Some text is obligatory.

3. Click the Save changes button.

8.2.3 Menus

There are two menus in Mahara:

• Links and resources

• Footer

Links and resources

The Links and resources menu appears to all users on most pages. You can decide which links or files are available
to everybody - also those without a login - and which ones only logged-in users shall see.

1. Choose which Links and resources menu you want to edit: the public or the logged-in users one.
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Figure 8.19: Edit site pages

Figure 8.20: Add external links to the Links and resources menu
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2. Choose the type External link.

3. Give your link a name that will appear in the menu.

4. Provide the full URL to the link including http:// or https://.

5. Click the Add button.

You can also link to files that you have uploaded to the site files area.

Figure 8.21: Add a site file to the Links and resources menu

1. Choose which Links and resources menu you want to edit: the public or the logged-in users one.

2. Choose the type Site file.

3. Give your site file a name that will appear in the menu.

4. Choose the file you want to display.

5. Click the Add button.

Once you have added links and files to your menus, you can edit or delete them.

Note: If you wish to display your links and resources in a specific order, map that order out before you add the
links and files because you cannot change the order afterwards.

Figure 8.22: Links and resources menu result

Footer menu

You have control over which links are displayed in the footer on each page.

1. Select which pages shall appear in the footer on each page. You can change the text of “Terms and Condi-
tions”, “Privacy Statement” and “About” in Edit site pages.

2. Click the Save changes button to save your selection.

8.2. Configure site 131



Mahara Documentation, Release 1.4

Figure 8.23: Footer menu

8.2.4 Networking

Mahara’s networking features allow it to communicate with Mahara or Moodle sites. If networking is enabled,
you can use it to configure single sign-on (SSO) for users who log in at either Moodle or Mahara or allow users
from another Mahara instance to access yours.

From Moodle 2.0 on you can connect Mahara and Moodle to save certain content you created in Moodle through
the portfolio feature.

In order to use networking site-wide with any institution, you need to:

1. Choose “Yes” from the drop-down menu at Enable networking.

2. Decide whether you wish to auto-register all hosts or not. If you choose “Yes”, an institution is created
for any host that connects allowing these users to log in to your Mahara site. We recommend you leave the
default “No” because that gives you more control over which Moodle or Mahara instances can connect.

3. Click the Save changes button.

Depending on which site you wish to connect, you may need to provide some of the other information on the page,
in particular the WWW root and the public key.

See Also:

The comprehensive guide for setting up a Mahoodle can be consulted when connecting Mahara and Moodle.

8.2.5 Pages

You create and copy site pages like regular portfolio pages. You do not have all blocks available. Check the blocks
in various contexts for blocks that you can use in site pages.

Once you are done creating your site pages, you can share them with others on Mahara.

8.2.6 Share

You share site pages like any other page.

See Also:

Refer to the share options for regular portfolio pages for further information.

132 Chapter 8. Site administration

http://moodle.org
http://docs.moodle.org/22/en/Portfolios
https://wiki.mahara.org/index.php?title=System_Administrator%27s_Guide/Moodle%2F%2FMahara_Integration


Mahara Documentation, Release 1.4

Figure 8.24: Networking overview

Figure 8.25: Site pages

Figure 8.26: Share site pages
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8.2.7 Files

Here you can upload files that you can include in the links and resources menu or in site pages. You can add files
that are in the home directory to the menu with resources for logged-in users. Files that you save in the public
folder can be used in the menu for users who are not logged-in.

See Also:

The process of uploading and managing files is very similar to files in your personal files area.

Figure 8.27: Site files

8.3 Users

In the Users menu of the site administration you can:

• search for users

• change settings for individual users

• suspend and delete users

• make users site staff or administrators

• check the admin notification settings

• add users manually or by CSV

8.3.1 User search

Site administrators can search for any user on the entire site. You can search for their

• first name

• last name

• display name

• username

• email address

Note: The display name is not shown in the user list. That will be a feature of Mahara 1.5.

You can combine any search and filter options. However, if you use too many, you may not yield any results.

1. Filter the users you wish to display by their initials of the first and / or last name.

2. Type the name, display name, username or email address or any partial thereof you wish to search for in the
search field.

3. Choose the institution from the drop-down menu in which you wish to search for the user.

4. Click the Search button to start searching.
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Figure 8.28: User search

5. View your results. The default order is alphabetically according the the first name. However, you can change
the order of the results by clicking on a heading and sort that column in ascending or descending order.

6. Click on the username of the user for which you want to take further actions.

8.3.2 User account settings

On the Account settings page of a user in the administration area, you can perform a number of actions to manage
the user’s account. However, you cannot change personal information about this user, e.g. name, email, from this
page. This can only be done in the Content area of the user’s account.

1. Login as this user

2. Change site account settings

3. Change institution settings

4. Suspend and / or delete this user

Login as

As administrator you have the power to log in as any user that you manage ans masquerade as them. If you are a
site administrator, you can log in as any user while institution administrators can only perform this action for any
user who is in their user management.

It is a great function for troubleshooting a user account because you see everything as the user would without
having to know his password.

Warning: This function can easily be misused by an administrator because he can make changes to the user’s
portfolio and artefacts as well as participate in groups while logged in as that user. Users should be aware of
this function and that an administrator can enter their account.
Sites should have clear policies around the use of this function so that the privacy of users and their portfolios
and collaborative work is protected. Therefore, there should also not be many users within an institution who
have administrator rights.

1. Click on the user’s name to go to his profile page.

2. Click on the Login as button to become that user. You see a red bar at the top of the browser window telling
you that you are masquerading as another user.
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Figure 8.29: Overview of the user account settings page

Figure 8.30: Login as another user
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Figure 8.31: Stop masquerading as another user

When you want to return to your own account again, click the Become [your user name] again link at the top of
the browser window.

Change site account settings

You can view and change a number of settings for a user’s account.

Note: Depending on the authentication method that is associated with this user, you may not be able to edit all
settings.

1. Change username: Give the user a different username. This field is not available when the account is
managed by an external authentication method.

2. Reset password: Change the password for this user account. This field is not available when the account is
managed by an external authentication method.

3. Force password change on next login: Check this box if the user shall change his password when he next
logs in. This field is not available when the account is managed by an external authentication method.

4. Site staff: Check this box if the user shall be able to create controlled groups.

5. Site administrator: Check this box if the user shall have full administrative rights.

6. Email: Check this box to disable the sending of emails for this user. If email is disabled notifications and
messages can only be viewed in the internal inbox. Depending on your setup, if emails are bounced back to
the sender, then email may be automatically disabled.

7. Account expires: Choose the date on which the user’s login is automatically disabled. The default setting
is that the date is not specified. You always see the current date in the greyed out date fields. You can set an
automatic account expiry date for all users in the account settings of the site configuration.

8. File quota (MB): Change the storage allowance for a user’s personal files area. The default value as set in
the files configuration in the plugin administration.

9. Authentication method: Choose the authentication method that the user uses to log in to Mahara. The
authentication methods can be set up in the institution administration. Depending on the authentication
method that you have chosen, you may have to provide a remote username to allow the user to log in.

10. Click the Save changes button when you are done editing the settings.

Warning: When the email address is disabled, users cannot reset their passwords themselves as no email can
be sent.
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Figure 8.32: Site account settings of a user
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Change institution settings

You can view and change settings regarding a user’s membership in institutions. Depending on the site settings
for institutions, a user may be added to more than one institution.

Figure 8.33: Institution settings for a user

1. Choose the institution from the drop-down menu to which you want to add this user.

2. Click the Add User to Institution button to make him a member of this institution.

3. Membership expires: If you wish, specify the date when the user will be removed from this institution
automatically. If you click the “Not specified” check box, no end date will be set.

4. ID number: Provide an optional identifier for this user in this institution. This field is not editable by the
user.

5. Institution staff: Check this box if you want to give this user staff rights in this institution. This will allow
him to create controlled groups.

6. Institution admin: Check this box if you want to make this user an administrator of this institution. This
will allow him to manage all users in this institution.

7. Click the Update button to save your changes.

8. Click the Remove user from this institution button to disassociate this user from this institution. The user
will stay in any other institution that he may be in, and he will also keep his account no matter whether he
is in an institution or not.
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Suspend user

Suspend a user if he does not follow the terms and conditions of the site and behaves inappropriately. Suspended
users cannot log in, but all their content is still available.

Figure 8.34: Suspend a user

1. Provide a reason for your suspension. This is particularly useful when you are not the only administrator
and / or need to remember after some time why you suspended this user.

2. Click the Suspend User button to disallow the user from logging in.

When a user has been suspended, the following suspension message appears on his account settings stating the
reason for the suspension and giving the administrators the possibility to unsuspend the user by clicking on the
Unsuspend User button.

Figure 8.35: Suspension notice on the account settings page

When the user tries to log in, he will see the suspension message and the reason. He can then contact an adminis-
trator via the “Contact Us” form for further action.

Figure 8.36: Suspended user tries to log in and gets suspension message
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Delete user

A user can delete his own account from Mahara on his account settings if he is allowed to by his institution. Site
administrators can also delete user accounts at any time.

Figure 8.37: Delete a user account

Click the Delete User button to delete this user account permanently. This action cannot be undone. As this is a
permanent action, you see a confirmation pop-up window that you will have to acknowledge.

Warning: When you delete a user account, all personal data is wiped from the system. This applies to
everything that is in a user’s Content and Portfolio area. This action cannot be undone. His contributions in
groups, e.g. forum messages, uploaded files and pages created in a group, are still available, but are made
anonymous by changing the name the “Deleted user” as author where an author is shown.

Note: If an account was deleted by accident - either by a user or by an administrator - swift action may result in
recovery of (most of) the data from a backup file. This requires access to the server’s backups and the backend of
Mahara. More information is available on the wiki.

8.3.3 Suspended users

A list of all suspended users is available in the sub-menu Suspended users. Here you can unsuspend or delete
them.

Figure 8.38: List of all suspended users

1. Select the user(s) for which you want to perform the same action.

2. Click the Unsuspend Users button to reinstate the accounts for all selected users.

3. Click the Delete Users button to delete all selected users in bulk. This account cannot be undone and all
personal information of these users will be deleted (see delete user).

8.3.4 Staff users

On this page you can choose which users receive site staff rights. Potential staff members - any user on the site -
are listed on the left while existing site staff members are listed on the right.
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Figure 8.39: Give site staff rights

1. From the list under Potential Staff, select the users you wish to make site staff. You can also select multiple
users at once using Ctrl and Shift click.

2. If you have too many users on your site and you cannot see / find the user you want, you can search for him
in the Search box.

3. Add the potential staff members to the right-hand side - Current Staff - by clicking on the right-arrow

button .

4. If you want to remove an existing or accidentally added site staff member, you can remove him from the list
on the right-hand side by clicking on him.

5. Then click on the left-arrow button , and he is removed from the list.

6. When you have chosen all members you wish to make site staff, click the Submit button.

8.3.5 Site admins

Site administrators have powerful rights on Mahara. They can make far-reaching changes and also log in as other
users. Be careful whom you give these rights. One site administrator is needed for each site. The total number of
site administrators should be kept small.

Figure 8.40: Give site admin rights
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1. From the list under Potential Admins, select the users you wish to make site administrators. You can also
select multiple users at once using Ctrl and Shift click.

2. If you have too many users on your site and you cannot see / find the user you want, you can search for him
in the Search box.

3. Add the potential site admin to the right-hand side - Current Admins - by clicking on the right-arrow

button .

4. If you want to remove an existing or accidentally added site admin, you can remove him from the list on the
right-hand side by clicking on him.

5. Then click on the left-arrow button , and he is removed from the list.

6. When you have chosen all members you wish to make site admins, click the Submit button.

8.3.6 Admin notifications

The Admin Notifications page lists all users with institution and site admin access on your site. It shows their
selected notification preferences for all admin notifications. There should be at least one administrator receiving
each type of message generated. Admin notifications are:

• Contact us

• Objectionable content

• Repeat virus upload

• Virus flag release

Figure 8.41: Overview of the admin notification types

8.3.7 Add user

You can add users to your site by creation accounts for them manually one by one.

1. Click the Create new user from scratch radio button if you want to create an empty account. Provide the
first name, last name and email address for this user.

2. Click the Upload Leap2A File radio button if you want to import a user from another Mahara instance or
a system that supports the Leap2A standard. Such a user could have exported his portfolio from another
Mahara instance.

3. Give the new user a username. The username may contain letters, numbers and most common symbols. It
must be from 3 to 236 characters in length. Spaces are not allowed.

4. Choose a password for the account. The password must be at least six characters long and contain at least
one digit and two letters.

5. Check this box if the new user should have site staff rights.

6. Check this box if the new user should have site administrator rights.
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Figure 8.42: Add a user manually

7. Review the allocated file quota. You may change it here for this user.

8. Choose the institution of which the user should be a member.

9. Check this box if the new user should have institution administrator rights in the chosen institution.

10. Click the Create User account button.

11. The user will receive an email with his account details.

Note: You can change the settings under Basic Details on the account settings page.

8.3.8 Add users by CSV

You can use this function to upload new users in bulk via a csv file (comma-separated file). The first row of your
csv file should specify the format of your data. For example, it should look like this:

username,password,email,firstname,lastname,studentid

This row must include:

• username

• password

• email

• firstname

• lastname

It must also include fields that are mandatory for all users to fill out and any fields locked for the institution you
are uploading the users for.

All other fields are optional. This is the full list of fields that you can add in addition to your csv file upload

• studentid - Student ID is displayed in the profile

• preferredname - Display name

• introduction - Introduction is displayed in the profile

• officialwebsite - Official web site

• personalwebsite - Personal web site

• blogaddress - URL to the blog

• address - Street address
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• town - Town

• city - City

• country - Country

• homenumber - Home phone number

• businessnumber - Work phone number

• mobilenumber - Mobile phone number

• faxnumber - Fax number

• icqnumber - ICQ nickname

• msnnumber - MSN nickname

• aimscreenname - AIM screen name

• yahoochat - Yahoo Chat username

• skypeusername - Skype ID

• jabberusername - Jabber ID

• occupation - Occupation is displayed in the profile

• industry - Industry is displayed in the profile

• maildisabled - Selection to disable the email address

• remoteuser - Remote username for external authentication

When you have created your csv file, you are ready to upload it.

Figure 8.43: Add users by csv file

1. Institution: Choose the institution and the authentication method for the user accounts that you upload.
You cannot change the authentication method later on in bulk, but only for each user individually.

2. CVS file: You must upload a csv file by clicking on the Browse button and then selecting it from the files
on your computer.

3. Force password change? If you select this option, users need to change their password before they can log
in for the first time.

4. Email users about their account? If you select this option, users will receive an email with their account
information. This is in particular good for internal accounts. For user accounts that are managed for example
by SSO with Moodle or through LDAP, you do not have to select this option because the users should already
know their login information.

5. Click the Add Users by CSV button to upload the users.
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Note: Depending on your server settings and / or the size of your installation, you may not be able to upload all
user accounts at once. You may wish to upload them in bunches of 100 instead.

8.4 Groups

In the Groups menu of the Site administration you can:

• add administrators to groups

• delete groups

• manage group categories

8.4.1 Overview

The first page you see when you click on the Groups menu is the Administer Groups page.

1. Search a group by its name or category.

2. Group name. The table is sorted alphabetically according to the group names.

3. Number of group members

4. Number of group administrators

5. Group type

6. Group category

7. Visibility

8. Click the Manage button to add or remove group administrators.

9. Click the Delete button to delete a group.

8.4.2 Add / remove group administrators

You can add to or remove administrators from a group by clicking on the Manage button on the Administer
Groups page.

Figure 8.44: Add or remove group administrators
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1. From the list under Potential Admins, select the group members you wish to make group administrators.
You can also select multiple users at once using Ctrl and Shift click.

2. If you have too many users on your site and you cannot see / find the user you want, you can search for him
in the Search box.

3. Add the potential administrator to the right-hand side - Current Admins - by clicking on the right-arrow

button .

4. If you want to remove an existing or accidentally added group administrator, you can remove him from the
list on the right-hand side by clicking on him.

5. Then click on the left-arrow button , and he is removed from the list.

6. When you have chosen all members you wish to make group administrators, click the Save button.

8.4.3 Manage group categories

Group categories help you to filter your groups more easily on the My groups and Find groups pages. A group
administrator can always assign one group category to a group if categories are enabled.

Site administrators can manage group categories on the Group Categories page under Groups in the Site Adminis-
tration.

Figure 8.45: Manage group categories
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1. Enable group categories for the entire site by placing a checkmark into the check box and then click the
Submit button.

2. Existing group categories are listed.

3. Create a new group category by typing its name and then clicking on the Add button.

4. Edit a group category name by clicking on the Edit button , change the name and then click on the
Update button. If you want to abort the action, click on the Cancel button.

5. Click on the Delete button to permanently delete a group.

Note: Group categories are not hierarchical and are available to everybody on the site. Any user who can create
groups can assign a group category.

8.5 Institutions

You can use Mahara as multi-tenanted instance. That means that several different institutions can share one
Mahara installation. That allows users from these different institutions to:

• share portfolio pages with each other

• give feedback on each other’s pages

• work collaboratively in groups across institution boundaries

In the Site Administration you can set up as many institutions as you wish. Institution administrators can only
administer their users but not make any changes to site settings.

You can also use the possibility to set up institutions if you wish different parts of your organisation to use different
themes, have different default settings and / or authentication methods.

8.5.1 Overview

On Site Administration -> Institutions -> Institutions you see an overview of all institutions that exist on this
Mahara installation.

Figure 8.46: Overview page for institutions

1. Search for a particular institution by its name.

2. Institutions are listed alphabetically
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3. Number of registered members in this institution

4. Maximum allowed members in this institution

5. Number of institution members with staff rights

6. Number of institution members with institution administrator rights

7. Click the Edit button to change institution settings.

8. Click the Delete button to delete an institution. You can only delete an institution when there are no
members in it.

9. Click the Add Institution button when you want to create a new institution.

10. Click the Edit Members button when you want to add or remove members from an institution.

11. Click the Edit Staff button when you want to add or revoke staff rights for an institution member.

12. Click the Edit Admins button when you want to add or revoke institution administrator rights for an institu-
tion member.

Note: The institution “No Institution” is the default “institution”. It cannot be deleted as it is the standard Mahara
site.

8.5.2 Add an institution

When you want to add an institution by clicking on the Add button on Site Administration -> Institutions ->
Institutions, you need to fill in basic information. You can change all the settings except the institution name later
on.

1. Institution name: This field is required. It is the unique identifier of this institution in the database. It must
only be one word without numbers and symbols.

2. Institution display name: This field is required. It is the name that all users see throughout the site to
identify this institution.

3. Institution expiry date: Set the expiry date for this institution by selecting the year, month and day from
the drop-down menus when taking the checkmark off the “Not specified” check box. Institutions do not
expire by default.

• If you specify an expiry date for this institution, two things will happen. Once the warning time
for institution expiry has been reached, site and institution administrators will be emailed about this
institution’s impending expiry.

• If the auto-suspend expired institutions option is set, then once the expiry date has been reached, this
institution will be automatically suspended, and users of this institution will no longer be able to log
in.

• The warning time for institution expiry and the auto-suspend expired institutions options can be found
in the institution settings under Site Administration -> Configure Site -> Site options.

4. Registration allowed? Check this box when you want to allow self-registration of new users. As institution
administrators, you will be asked to confirm that users can join your institution. If you decline, their account
will be associated with “No Institution”. When you do not allow registration, nobody can ask to join your
institution or leave it without your permission.

5. Default membership period: You can set how long users will remain associated with this institution per
default. Choose an option from the drop-down menu and then specify the number of days, weeks, months
or years. After this length of time, the users will be removed from the institution. Users will receive an
email before this time reminding them that they will be removed soon. However, that does not mean that
they will lose their account. They will still have that.
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Figure 8.47: Add a new institution
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6. Theme: Use the drop-down menu to choose the theme that you wish to use for this institution. All pages
in that institution will receive that theme. When users from other institutions view portfolio pages that were
created in this institution, they will see this institution’s theme on these pages. If Site Default is selected,
when a site administrator changes the site default theme, the theme for the users of this institution will
change, too. You can install more themes in the theme folder on the server. Check out the community-
contributed themes.

7. Maximum user accounts allowed: Specify the maximum number of accounts that can be created in this
institution. If you leave this field blank, there is no limit to the number of accounts.

8. Locked fields: Put a check mark into each check box for which users are not allowed to change the value.
Disabled check boxes are for profile fields which are locked in the institution settings for “No Institution”.
These profile fields are locked at the site level and cannot be unlocked for individual institutions.

9. Click the Submit button to save your changes and create this institution.

10. Click the Cancel button to abort the creation of this institution.

Note: Locking profile fields such as first name, last name and display name can be beneficial for institutions that
wish to always identify their users by their real names and not allow users to choose nick names.

8.5.3 Edit an institution

Once you have created your institution, you can edit its settings or also suspend the institution. You will have to
choose at least one authentication method for this institution so that user accounts can be created.

Note: Only site administrators can add, edit and delete authentication methods for an institution and suspend it.

You can add multiple authentication methods to your institution and thus allow various entry points for your users.
You should set up at least one authentication method. Otherwise, nobody can log in to this institution.

Before you can use the IMAP, LDAP, SAML or XMLRPC authentication methods, you must install their exten-
sions:

• internal: user accounts are created by Mahara and the passwords and logins are kept in an internal database.

• IMAP: user accounts are authenticated against an IMAP server. This is the least maintained authentication
plugin and rarely used.

• LDAP: user accounts are authenticated against an LDAP server.

• SAML: a SAML 2.0 Identity Provider Service is needed that has the user accounts.

• XMLRPC: This is the authentication method used for MNet to connect Mahara with Moodle or another
Mahara.

• none: Anyone can log in by picking a username and password. This should only be used for testing.

Warning: Be careful when choosing the “None” authentication method. This allows anyone to log in. It
should only be used for testing purposes.

IMAP authentication

You can use this authentication method to receive the login information for your users from your IMAP server.

1. Authority name: Enter a descriptive name to help you identify this authority. Preferably, choose a short
name. This field is required.

2. Hostname or address: Specify the hostname in URL form. This field is required.
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Figure 8.48: Set up IMAP authentication

3. Port number: Specify the port under which your IMAP server can be reached. The default is 143. This
field is required.

4. Protocol: Selecte the IMAP protocol you are using by selecting it from the drop-down menu. This setting
is required:

• IMAP

• IMAP / SSL

• IMAP / SSL (self-signed certificate)

• IMAP / TLS

5. Password-change URL: If your users can only change their password in one central space, provide the
URL here.

6. Click the Submit button to save your changes.

7. Click the Cancel button to abort your changes.

LDAP authentication

Use this authentication method to authenticate again an LDAP server so that your users can log in with their usual
login and password.

1. Authority name: Enter a descriptive name to help you identify this authority. Preferably, choose a short
name. This field is required.

2. Host URL: Specify hosts in URL form, e.g. ldap://ldap.example.com. Separate multiple servers
with ; for failover support. This field is required.

3. Contexts: List the contexts where users are located. Separate different contexts with ;, e.g.
ou=users,o=org;ou=other,o=org. This field is required.

4. User type: Select from the drop-down menu how users are stored in the LDAP directory. This field is
required. You can choose between:

• Novell Edirectory

• posixAccount (rfc2307)

• posixAccount (rfc2307 bis)
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Figure 8.49: Set up LDAP authentication
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• sambaSamAccount (v. 3.0.7)

• MS Active Directory

• default

5. User atrribute: Enter the attribute used to search for users. It is often cn. This field is required.

6. Search subcontexts: Select “Yes” if you want to search for the users also in subcontexts. This setting is
required.

7. Distinguished name: If you want to use bind-user to search users, specify it here. It should look something
like cn=ldapuser,ou=public,o=org. Leave this blank for anonymous bind.

8. Password: Enter the password for the “distinguished name”.

9. LDAP version: Choose the LDAP version you are using from the drop-down menu. This setting is required.

10. TLS encryption: Check this box if you use this encryption mechanism.

11. Update user info on login: Check this box to update the first name, last name and email address with the
corresponding LDAP values at each login. Enabling this option may prevent some MS ActiveDirectory sites
/ users from subsequent Mahara logins.

12. We auto-create users: Check this box to create user accounts on Mahara automatically when a user authet-
icates successfully but does not yet have an account.

13. LDAP field for First Name: Enter the name of the field in the LDAP record that contains the user’s first
name.

14. LDAP field for Surname: Enter the name of the field in the LDAP record that contains the user’s last name.

15. LDAP field for Email: Enter the name of the field in the LDAP record that contains the user’s email
address.

16. Click the Submit button to save your changes.

17. Click the Cancel button to abort your changes.

SAML authentication

Choose this authentication method for your institution when you have a SAML 2.0 Identity Provider Service set
up for your organisation that allows you to use the same login for multiple applications.

1. Institution attribute (contains ”...”): Enter the attribute that will be passed from the Identity Provider (IdP)
that shows which institution the user belongs to. These usually directly correlate to LDAP attributes (the
signin service of the IdP), e.g. eduPersonOrgDN. This field is required.

2. Institution value to check against attribute: Enter the value that will be checked against the institution
attribute value as passed from the IdP. If the institution regex checkbox is selected, this value can be a regular
expression that will be used to check against the institution attribute value. This field is required.

3. Do partial string match with institution shortname: Check this check box to treat the value in “Institution
value to check against attribute” like a regular expression.

4. User attribute: Enter the name of the attribute passed by the IdP that contains the username. This field is
required.

5. Match username attribute to remote username: Check this box if you want to match the user attribute
value to the remote username field assigned to a given user (not the real Mahara username).

6. Update user details on login: Check this box to update the first name, last name and email address with
the corresponding IdP values passed through at each login.

7. We auto-create users: Check this box to create user accounts on Mahara automatically when a user authet-
icates successfully but does not yet have an account.

8. SSO field for First Name: Enter the name of the attribute passed by the IdP that contains the user’s first
name.
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Figure 8.50: SAML 2.0 authentication

9. SSO field for Surname: Enter the name of the attribute passed by the IdP that contains the user’s last name.

10. SSO field for Email: Enter the name of the attribute passed by the IdP that contains the user’s email address.

11. Click the Submit button to save your changes.

12. Click the Cancel button to abort your changes.

Warning: This security issue only affects sites which make use of the SAML authentication plugin and have
more than one SAML identity provider.
By default, SAML authentication instances have the “Match username attribute to Remote username” setting
unchecked. This means that a user logging in using single sign-on will log in as the local Mahara user whose
Mahara username matches their SAML username attribute.
In this configuration, someone with control over any SAML identity provider could gain control over any user
account on that Mahara site by setting the username attribute appropriately. In other words, administrators of
one institution could control users in other institutions.
To fix this, site administrators of multi-institution sites with SAML authentication in use should ensure that the
“Match username attribute to Remote username” setting is enabled in each SAML-enabled institution, unless
usernames are guaranteed to be unique across all SAML providers.

MNet / XMLRPC authentication

Use the XMLRPC authentication for connection a Mahara instance to a Moodle or other Mahara installation for
sharing login information. With Moodle 2 that does not only mean that you can log in to Mahara via Moodle, but
also that you can transfer certain activities into your Mahara portfolio from Moodle.

A Moodle site can only be connected to Mahara once no matter how many institutions you have set up.

Note: You must have networking enabled in order to use this authentication method.
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Figure 8.51: Set up MNet authentication

156 Chapter 8. Site administration



Mahara Documentation, Release 1.4

1. Authority name: Enter a descriptive name to help you identify this authority. Preferably, choose a short
name. This field is required.

2. WWW root: Enter the web address of the root of the remote application, e.g. http://example.com.
This field is required.

3. Site name: Enter the name to present to your users to identify the remote site. If you enable SSO, they may
click on this name to start a session at the remote site. This fiel is required.

4. Application: Choose the application on the other end. You can choose between “Mahara” and “Moodle”.

5. Port number: Enter the port number that the remote application is listening at. You probably will not
need to change this unless you are connecting to a https service or your remote application is running on a
non-standard port. This field is required.

6. Parent authority: If you set a parent authority from the already existing authentication methods, users will
be able to log in using that authority as well as MNet. For example, you could set up LDAP authentication
and have that be the parent of this MNet authority. That means that users will be able to log in via Mahara’s
in-built login form using their LDAP credentials as well as via MNet from their Moodle. You do not have
to set a parent authority. If you do not, users using MNet will only be able to access Mahara via MNet, i.e.
log in to Moodle or the other Mahara first.

7. Wrong login box message: Enter a message to display when a user tries to log in via Mahara’s login form
but is not allowed to if you have not set up a parent authority.

8. SSO direction: Choose your SSO direction from the drop-down menu:

• They SSO in: Enable this option to allow users from the remote site to roam to your Mahara site
without having to enter their username and password.

• We SSO out: Enable this option to allow your users to roam from Mahara to the remote site without
having to enter their username and password there.

9. Update user info on login: Enable this option to bring over user data from the remote site upon login and
update your Mahara user record with any changes. The following fields, when filled in on Moodle, are filled
in Mahara:

• first name (always carried over)

• last name (always carried over)

• email address (always carried over)

• profile picture

• description (introduction on Mahara)

• city

• country

• language

• HTML editor setting

10. We auto-create users: Check this box to create user accounts on Mahara automatically when a user authet-
icates successfully but does not yet have an account.

11. We import content: Not all network-enabled applications support this, but if they do, e.g. Moodle 2.x, this
will allow users of the remote site to import content to Mahara. It depends on the option “They SSO in”
from “SSO direction” and it is sensible to also have “We auto-create users” set.

12. Click the Submit button to save your changes.

13. Click the Cancel button to abort your changes.

See Also:

Refer to the comprehensive guide about setting up Mahoodle, the combination of Mahara and Moodle, for step-
by-step instructions on how to set everything up on the Moodle side and on Mahara. The guide explains the steps
for both Moodle 1.9 and Moodle 2.x.
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Order of authentication methods

If you have set up multiple authentication methods in one institution, you can decide on the order in which are
checked.

Figure 8.52: Order of authentication methods

1. Use the up arrow and down arrow to move a specific authentication method up or down in the list.

2. Delete a particular authentication method by clicking on the Delete link [x].

Note: You cannot delete an authentication method when there are still users who require it to log in. Before
deleting an authentication method, you have to move the users to another authentication method.

8.5.4 Members

Under Institutions -> Members you can add and remove members from one institution in bulk. As site adminis-
trator, you can always add members to an institution. As institution administrator, you can only invite users to
become members.

You can filter users to display fewer and add to or remove them more easily from your institution:

• People who have requested institution membership

• People who have not requested institution membership

• People who are already institution members

People who have requested institution membership

If your institution allows self-registration, users who are not already members of your institution can request to
join it.

See Also:

You can check your settings on self-registration:

• when you are an institution admin: Institution administration -> Manage institutions -> Settings -> Regis-
tration allowed?

• when you are a site admin: Site administration -> Institutions -> click the Edit button next to the
institution you want to check -> Registration allowed?

Users can ask to join an institution on their institution membership page.

Institution administrators receive notifications about membership requests. Site administrators only receive noti-
fications about users wanting to join “No Institution”.

1. Users to display: Choose People who have requested institution membership.

2. Institution: Choose from the drop-down menu to which institution you wish to add users. If there is only
one institution, its name will be displayed without the drop-down menu.

3. Users who have requested membership: Select the users you wish to add to the institution.

4. Search: You can also search for users in the search box if there are too many names listed.
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Figure 8.53: Deal with an institution membership request

5. Add the users by clicking on the right-arrow button .

6. Users to be added / rejected: If you put users into the box for users to be added / rejected by accident, you
can remove them from that list by clicking on them.

7. Then click on the left-arrow button , and they are removed from the list.

8. When you have all the members you wish to add to the institution, click the Add members button.

9. Alternatively, if you wish to decline users membership, you can select them and then send a general denial
by clicking on the Decline requests button.

People who have not requested membership yet

An admin can also take the initiative and invite users into an institution.

Figure 8.54: Invite users to become institution members

1. Users to display: Choose People who have not requested membership yet.

2. Institution: Choose from the drop-down menu to which institution you wish to invite users. If there is only
one institution, its name will be displayed without the drop-down menu.

3. Non-members: Select the users you wish to invite to the institution.

4. Search: You can also search for users in the search box if there are too many names listed.

8.5. Institutions 159



Mahara Documentation, Release 1.4

5. Add the users to the list Users to be invited by clicking on the right-arrow button .

6. If you put a person into the box for users to be invited by accident, you can remove them from that list by
clicking on them.

7. Then click on the left-arrow button , and they are removed from the list.

8. When you have all the members you wish to invite to the institution, click the Invite users button.

9. The users receive a notification and can accept or decline the institution membership invitation.

People who are already institution members

You can remove users from an institution, e.g. if they are no longer students at a school or university, but should
still have an account on Mahara or when they are just switching institutions on the same Mahara instance.

Figure 8.55: Remove users from an institution

1. Users to display: Choose People who are already institution members.

2. Institution: Choose from the drop-down menu which institution’s members you wish to display. If there is
only one institution, its name will be displayed without the drop-down menu.

3. Current members: Select the users you wish to remove from the institution.

4. Search: You can also search for users in the search box if there are too many names listed.

5. Add the users to the list Users to be removed by clicking on the right-arrow button .

6. If you put a person into the box for users to be removed by accident, you can remove them from that list by
clicking on them.

7. Then click on the left-arrow button , and they are removed from the list.

8. When you have all the members you wish to remove from your institution, click the Remove users button.

8.5.5 Institution staff

You can give users staff rights in an institution in which they are members. The staff role will allow them to create
course groups. This page allows you to do that in bulk for many users at once.

See Also:
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You can also give staff rights on the user account settings page.

Figure 8.56: Give users institution staff rights.

1. Institution: Choose the institution from the drop-down menu for which want to give staff rights to members.

2. Institution Members: Select the institution members who shall get staff rights.

3. Search: You can also search for users in the search box if there are too many names listed.

4. Add the users to the list Institution Staff by clicking on the right-arrow button .

5. If you put a user into the institution staff list by accident or want to remove existing staff members and
return them to normal membership status, select them.

6. Then click on the left-arrow button , and they are removed from the list.

7. When you have all the members you wish to have as staff in the institution, click the Submit button.

8.5.6 Institution administrators

You can give users admin rights in an institution in which they are members. The administrator role will allow
them to manage users in their own institution. This page allows you to do that in bulk for many users at once.

See Also:

You can also give admin rights on the user account settings page.

Figure 8.57: Give users institution admin rights.

1. Institution: Choose the institution from the drop-down menu for which want to give admin rights to mem-
bers.
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2. Institution Members: Select the institution members who shall get admin rights.

3. Search: You can also search for users in the search box if there are too many names listed.

4. Add the users to the list Current Admins by clicking on the right-arrow button .

5. If you put a user into the institution admin list by accident or want to remove existing admin members and
return them to normal membership status, select them.

6. Then click on the left-arrow button , and they are removed from the list.

7. When you have all the members you wish to have as admins in the institution, click the Submit button.

8.5.7 Institution pages

You can create pages for your entire institution. Although you could always create pages under a regular user
account that other users could copy into their own portfolio, the advantage of institution pages is that new members
in the institution can receive a copy upon joining the institution.

Figure 8.58: Create institution pages

1. When you are in Site administration -> Institutions -> Pages, click on the institution in the drop-down menu
for which you want to create or edit institution pages.

2. If you have a lot of institution pages, you can search for a particular one by searching for it. You can search
in the title, description and tags or only in tags.

3. Click on the Create Page button to start a new institution page.

4. Click on the Copy Page button to start a new page from a copy of an already existing one. This does not
have to be an institution page but can be any page that you are allowed to copy.

5. View an institution page that you have already created.

6. Click on the Edit button to change an existing institution page.

7. click on the Delete button to delete an institution page.

Note: Creating and editing an institution page is very similar to creating and editing a portfolio page. Not all
blocks are available when editing an instituion page in the page editor though due to the different context. Please
refer to the overview of blocks for a list of all the blocks that you can use in an institution page.

8.5.8 Share institution pages

You can see a list of all institution pages from an institution under Site administration -> Institutions -> Share.

1. Select the institution from the drop-down menu for which you want to see the institution pages.

2. Pages: All institution pages for that institution are listed here.

3. Access list: View the access permissions for the pages.
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Figure 8.59: Share institution pages

4. Click on the Edit Access button to change the permissions of who can view and copy a page.

5. Click the Secret URL edit button to define a secret URL for a page.

Sharing an instution page is very similar to sharing a portfolio page. The only difference is that you can allow
new institution members to receive a copy of an institution page immediately upon joining the institution.

Figure 8.60: Setting for copying an institution page for new institution members

1. When you clicked on the Edit Access button on the Share page for institution pages, click on the check
box Allow copying under Advanced Options.

2. Once you have put a check mark into that box, the line Copy for new institution members will appear and
you can place a check mark into that box if you wish all new institution members to receive that page
automatically.

8.5.9 Files

The files area in an institution holds all files that are uploaded by institution administrators as institution files. The
uploading process works as the one in the personal files.
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8.6 Extensions

Extensions in Mahara serve to provide certain functionality in the system. Extensions can be installed at any point
and also hidden.

8.6.1 Plugin administration

The Plugin administration lists all the plugins that are currently installed on your Mahara and provides a link to
the plugin configuration settings where available.

Plugins in Mahara are always installed and can be accessed if users know the URLs and would otherwise have
access. Rather than enabling and disabling the functionality, plugins are hidden or made visible by clicking on the
hide or show links beside the plugins. When hiding an artefact type plugin, Mahara stops the display of the blocks
related to it.

In order to delete a plugin completely, you must delete the code and all database tables that pertain to the plugin.

Note: Core Mahara functionality can be made unavailable to users by hiding it. This may be useful if you
connect Mahara to another system that already provides this functionality or if you do not wish your users to use
that functionality. However, the decision about hiding a functionality should be considered thoroughly as it may
also mean that users may not be able to have as many artefacts available to them.

In the following, only the plugins that have additional settings are discuessed.

Blocktype: File / internalmedia

Configure which file types users can embed into the Embedded Media block. If you disable a file type that has
already been used in a block, it will not be rendered any more.

Mahara comes with Flowplayer, a media player that can play flv, mp4 (in H.264 format) and mp3 files. Videos
are embedded and audio files played with the help of this player.

Other video file types can be enabled, but users must have the appropriate software installed on their computers
and the respective plugin enabled in their browsers to play them.

Figure 8.61: Configure the Embedded Media block

164 Chapter 8. Site administration

http://flowplayer.org/


Mahara Documentation, Release 1.4

1. Select the file types that you wish your users to be able to show on their portfolio pages.

2. Click the Save button to keep your changes.

Note: If you allow the embedding of file types that cannot be played by Flowplayer, some users may not have
the necessary software installed for displaying these file types.

Block type: Wall

You can limit the number of characters that are allowed for wall posts in this configuration setting. Existing posts
will not be changed.

Figure 8.62: Configure wall settings

1. Choose the maximum number of characters for your wall posts.

2. Click the Save button to keep your changes.

Artefact type: Comments

Turn comment ratings on to enable 5-star ratings in the feedback section on artefacts and pages.

Note: Ratings cannot be on their own and require either a comment or a file attachment.

Figure 8.63: Enable comment ratings

1. Click the check box to enable comment ratings.

2. Click the Save button to keep your changes.
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Artefact type: File

1. Default quota: You can set the amount of disk space that new users will have as their quota. Existing user
quotas will not be changed.

2. Maximum quota: You can set the maximum quota that an administrator can give to a user. Existing user
quotas will not be affected.

3. Upload agreement: Enable this option if you would like to force users to agree to certain terms before they
can upload a file to the site. They must accept this agreement before tey are able to choose a file from their
computer to upload to Mahara. A default agreement is provided, but you can also write your own and use
that instead.

4. Profile picture size: Choose the maximum size of the profile pictures for users. All images uploaded to the
profile pictures area will be resized to these dimensions.

5. Default comment permissions: The selected artefact types have comments enabled per default. Users can
override these settings for individual artefacts in the files area. You can enable comments for:

• file

• folder

• image

• profile picture

• archive, i.e. compressed file

6. Click the Save button when you are finished making your changes.

Artefact type: Profile

For profile information you can decide which fields a user must provide when a user account is created manually
or via csv file. These fields are marked mandatory.

The profile fields marked public are available for all logged-in users to search upon within another user’s public
profile area.

1. Select the fields that you wish to make mandatory and / or public.

2. Click the Save button to keep your changes.

Authentication: SAML

If you wish to use SAML authentication any where on your site, you must provide the path to your SAML php file
in these settings.

1. SimpleSAMLphp lib directory: Provide the fully qualified path to the library di-
rectory of SimpleSAMLphp, e.g. if the full path to the bootstrap autoload.php is
/some_path_to/simplesamlphp_1_3/lib/_autoload.php then this value should be
/some_path_to/simplesamlphp_1_3/

2. SimpleSAMLphp config directory: Provide the fully qualified path to the configuration directory
to be used for this Service Provider (SP) SimpleSAMLphp, e.g. if the full path to the con-
fig.php is /some_path_to/simplesamlphp_1_3/config/config.php then this value should
be /some_path_to/simplesamlphp_1_3/config/

3. Click the Save button to keep your changes.
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Figure 8.64: Choose mandatory and public profile fields

Figure 8.65: Prepare your site for SAML authentication
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Interaction: Forum

The post delay setting determines the time (in minutes) that users have for editing their forum posts before they
are mailed out. Once a forum post has been mailed and further edits are made, the date, time and editor are kept
track of in the post.

Figure 8.66: Set the edit time before the forum post is finalised

1. Set the time in minutes before a post is finalised and further edits are marked.

2. Click the Save button to keep your changes.

8.6.2 HTML filters

Mahara uses HTML Purifier to filter out malicious code that could threaten the security of the system. If you have
code, e.g. iFrames or javascript that you wish to use and that otherwise gets filtered out, you will have to write a
filter to circumvent that. Filters should always be specific to their purpose and not give ‘carte blanche’ to ensure
security as much as possible.

Mahara already comes with a number of installed filters. Others can uploaded and then be installed. If
you have downloaded a new set of HTML filters, you can install them by unzipping the file into the folder
/htdocs/lib/htmlpurifiercustom and then click the Install button.

8.7 Experimental features

As site administrator you have two experimental features available to you:

• bulk export of Leap2A files

• bulk import of Leap2A files

You cannot access these features from any navigation, but must type in the URL directly.

Warning: The export and import of portfolios uses quite a lot of computing power. Therefore, these bulk
options require even more memory. Please try them first out on a test installation or export / import only a
small number of users instead of an entire institution at once.

8.7.1 Bulk export of Leap2A files

[your regular Mahara URL]/admin/users/bulkexport.php

If you need to export the portfolios of multiple users at once, you can do so from the bulk export page. Please
remember that this is an experimental feature at the moment.

1. Institution: Choose the institution from the drop-down menu for which you want to export all user portfo-
lios in the Leap2A format.
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Figure 8.67: Experimental feature: Bulk export
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2. Usernames to export: Alternatively, choose this option if you only wish to export some users’ portfolios.

3. Click the Export users button to start the export process. This might take a while.

Note: You can look up the usernames on the user search page.

8.7.2 Bulk import of Leap2A files

[your regular Mahara URL]/admin/users/bulkimport.php

If you need to import the portfolios of multiple users at once, you can do so from the bulk import page. Please
remember that this is an experimental feature at the moment. You must have Leap2A files to import. The import
of HTML files is not possible.

The easiest option to import user portfolios in bulk is to use the bulk export file as all information is contained
therein. If that is not possible, you can create the necessary ZIP file manually.

Bulk import using a bulk export file

Figure 8.68: Experimental feature: Bulk import

1. Ideally, you have exported the users you wish to import using the bulk export functionality on the other
Mahara instance. Then the bulk export file already contains all necessary files and mappings.

2. Institution: Choose the institution in which the users shall become members.

3. Bulk export file: Choose the bulk export ZIP file which contains all users that shall be created. A new user
account will be created for each of them.

170 Chapter 8. Site administration



Mahara Documentation, Release 1.4

4. Email users about their account: Check this option if the new users shall receive an email about their
new account. This is especially important if you change their username and if they do not know that their
account has been moved.

5. Click the Import button to start the process. Please be patient as the import may take some time.

Note: Before importing these new user accounts, you can change the usernames for these new accounts in the
usernames.csv file that is included in the bulk export file.

Bulk import from scratch

If you want to import user portfolios into one institution using their Leap2A files that you did not receive via the
bulk export functionality, you can still import them in bulk.

1. Create a folder, e.g. mahara-bulk-import.

2. Create the CSV file usernames.csv in the folder mahara-bulk-import.

3. Create a line for each user that you are importing that contains the username and the name of the ZIP file
that contains the corresponding Leap2A file.

4. Create the sub folder users in it. Do not choose a different name.

5. Place all Leap2A files that you wish to import into one institution into the users sub folder. Make sure that
each ZIP file has a corresponding entry in usernames.csv.

6. Create a ZIP file from the folder mahara-bulk-import once you have all users in it.

7. Go to [your regular Mahara URL]/admin/users/bulkimport.php.

8. Institution: Choose the institution in which the users shall become members.

9. Bulk export file: Choose the bulk export ZIP file which contains all users that shall be created. A new user
account will be created for each of them.

10. Email users about their account: Check this option if the new users shall receive an email about their
new account. This is especially important if you change their username and if they do not know that their
account has been moved.

11. Click the Import button to start the process. Please be patient as the import may take some time.

Note: The CSV file usernames.csv should look like this and does not have a header row:

"petra","mahara-export-leap-user4-1334451885.zip"

"polly","mahara-export-leap-user5-1334451888.zip"
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CHAPTER

NINE

INSTITUTION ADMINISTRATION

Institution administrators can manage their users and institution pages, but they cannot make any changes to the
site itself. They can:

• change select institution settings

• search for users within their institution(s)

• suspend users within their institution(s)

• add users one by one or per csv file

• invite users to their institution

• remove users from their institution

• grant institution members staff and administrator roles

• create and share institution pages

• upload institution files

Most of the functionality is very similar to what site administrators can do for users and in institutions.
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CHAPTER

TEN

MOBILE MAHARA

You can user Mahara to a certain degree from a mobile device such as a smartphone or tablet that has internet
browser capabilities. Depending on the device, not all functions may be available to you.

When you have an Android device or an iPhone, you can use an application to upload files directly from your
device to Mahara.

10.1 MaharaDroid

The open source software MaharaDroid enables Android devices to share / upload content to a Mahara instance.
This can basically be any content that you can share on your Android mobile phone ot tablet.

You do not have to install any additional software for Mahara in order to use this functionality. Follow the
instructions on the MaharaDroid site for more information on how to set up the application and link it to your
Mahara.

10.2 PortfolioUp

PortfolioUp is an image uploader for Mahara that can be used on the iPhone. You need to install an additional
plugin on your Mahara instance in order to use this app.

For documentation writers
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CHAPTER

ELEVEN

TODO LIST

Todo

Where can you change the setting for when the email digest is sent?

(The original entry is located in /home/docs/sites/readthedocs.org/checkouts/readthedocs.org/user_builds/mahara/checkouts/1.4_STABLE/source/account/notifications.rst,
line 38.)

Todo

Check which blocks can be copied and which ones cannot.

(The original entry is located in /home/docs/sites/readthedocs.org/checkouts/readthedocs.org/user_builds/mahara/checkouts/1.4_STABLE/source/portfolio/share.rst,
line 97.)
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CHAPTER

TWELVE

INFORMATION FOR MAHARA
DOCUMENTATION WRITERS

This is a list in progress as I work on the documentation. There are a number of things for which I create
conventions. I want to keep them in a central space so that others have access to them and that I can refer to them
as well. ;-)

The list is not in any particular order.

• Screenshots are placed as figures and always include alt text and a figure description. The latter will receive
numbering in the PDF export.

• Admonitions in use are:

– note: for anything that should receive a bit more attention

– warning: for anything that needs to be done with caution

– seealso: for references to other documents if they need special attention. References to other docu-
ments can also be included in the text inline.

– todo: for keeping a running ToDo list

• Buttons such as Save or Copy page and also portfolio sections such as Content, Porfolio etc. are highlighted
as emphasized text (with a single *).

• Little buttons can be included in the text.

• Screenshots of Mahara sections are not made inline, but receive the “figure” directive. They always have an
alt tag and also a brief description which will show up below the image and is numbered in LaTeX PDF.

• Screenshots should have as little instructions as possible about the steps that are to be taken in them. Prefer-
ably, only the step numbers so that they can be exchanged more easily and the text of the steps is translatable
because it is text and not part of the image. That could also mean that translators can translate the steps but
don’t immediately have to change the screenshot.

• Inline images that are refered to in the textsuch as should be included as shortcuts with the reference at
the bottom of the page.

• An index entry should be created for each section.

• Long sections should be broken up into several pages to make the editing more manageable.

• reStructuredText does not have a set hierarchy of heading levels. They depend on the individual files.
However, to be consistent, the following convention exists:

– Heading 1, e.g. 1.: ===============

– Heading 2, e.g. 1.1.: —————

– Heading 3, e.g. 1.1.1.: ~~~~~~~~~~~~~~~

– Heading 4, e.g. 1.1.1.1.: ^^^^^^^^^^^^^^^
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• Headings below h4 should be avoided.

• I create screenshots with Shutter in Ubuntu. It is easy to add the callouts which indicate the steps to take.
However, any other screenshot software can be used. Preferably, the callouts look similarly. The color is
#4C711D.

• The callouts in the screenshots refer to the steps that need to be taken.

• Screenshots should only show the necessary area and not the entire screen or URL address bars etc. where
not necessary.
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